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What is New in Track’em? 
 

New with Trackem Release 2.4.7 
You can now print a list of missing name for a specificied number of meetings since a specified meeting 
number.  For example, if you want a list of all who missed the last two meetings since the 15th night, 
simply: 
1. Go to the preview screen. 
2. Set the Meeting cut-off number to 15 
3. Select the "Missed Last Meeting" option from the "Attendance Lists" menu. 
4. Enter the number "2" in the "Select a Meeting to View" box. 
Dont forget to either disable or change the  Meeting cut-off number after printing the list. 
 

New with Trackem Release 2.4.5 
- Added a new form to make entering Baptism appointments more user friendly.  Just click on Baptism 
Interview box and you will see the new form.  It gives you the option to click the day and time for the 
appointment. Simply reclick the day or time to remove it. 
- Added an new report to print out the appointment schedule.  The names are listed by Day and time.  It 
also shows their team number, decisions and phone number. 
- Added Notes and email fields to global search. Now you can search these fields. 

New with Trackem Release 2.4.0 
- Added a new field called "Email." Now you can enter email addresses and export them to be used with 
a broadcast mailer like "World Cast".   See page 41 in the new manual included with the upgrade. 
- Increased the length of the note field from 100 to 150 characters. 
- Changed the interface for entering the decisions along with the attendance.  Now you can select to enter 
the decision in the Decision record, Attendance field, or both.  Check it out at the Attendance Update 
Tool from the button bar, it is much more user friendly. 
- Added the capability to delete names from the preview window.  Click on the name to go to edit mode. 
Now the delete button and the SDA Menber button is activated.  Click the proper button to remove the 
name and you will be returned to the preview screen but that name will be gone. 
-This release also fixes various bugs found in the program. 

New with Trackem Release 2.3.105 
Bar Code Scanning Now Available 
You can get the scanner for 180.00   
The tags are .35 each (printed)  
For More information: contact George Garrick at cell # 423-956-6578  
or Bruce beacon at Cell # 704-517-4805  Tell them to mention my name George Garrick or The Light of 
Prophecy  
 

New with Trackem Release 2.3.95 
1. Can update attendance on multiple computers and merge them into the main database. 
2. Automatically check your mail lists and make sure you are only printing one label per household. 
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New with Trackem Release 2.3.45 
1. You can print a list of people who heard the Sabbath message but have not yet been visited.  From the 
Preview Screen Menu, select Visitation Tools, then Sabbath Visits. 
 
2. You can mark baptized names from the attendance update screen instead of going back a second time 
through the baptized names on the edit screen. 

New with Track'em Release 2.3.0 
1. The Printer Cut off setting is now shown directly on the Print Reports menu. 
2. You can now view attendance charts in Microsoft Excel.  You must have Excel for  
this option to work. 
 
3. You can automatically make a report in Microsoft Word to show all names and  
registration numbers using the Mailmerge feature and the Word Template Supplied.   
You must have MS word for this to work also. 
 
4. Enhanced mail list capabilities.  You can select a combination of filters from the  
preview screen and create a mail list from any possible combination.  You can also  
preview the list or even print out the mail list in list format before printing the labels. 
 
5. We added a duplicate address feature which gives you the option to view all names  
living at the same address.  You can select to further filter the names to only those  
with different last names or different team codes at the same address. 
 
6. Added a print feature to the Preview Screen.  Now you can print the reports directly  
from the preview screen. 
 
7. You can automatically save your filter selected in the preview screen when you  
switch back to the edit record screen.  For example if you are looking at the names  
arranged by interested level in the preview mode, you can check the save filter box  
and when you close the preview screen you will see the names in the edit mode  
arranged by interest level.  Simply click the Show All button to restore all names into  
the file. 
 
8. We have just finished two crusades with a large number of visitation teams working  
with us.  This gave us an opportunity to enhance the visitation tracking features.  You  
can now view each team list by simply clicking on the appropriate number at the  
bottom of the preview window.  We added is the capability to enter phone numbers  
for each team. 
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Understanding the Program 
 
The Track’em is a computerized interest management program that will put much needed information 
concerning evangelistic interests at your fingertips.  The program is entirely menu driven and user-
friendly.  Typists can be trained to use the program in as little as 30 minutes and can be reasonably 
proficient in a very short time.  However, in order to get maximum benefit from its many powerful 
features, you should carefully read all of the instructions given here and work through the tutorial. 

The Database is set up in a fashion that is similar to a file box.  The file would be similar to a file box, 
which contains one card from each person attending.  The information from each registration card is 
typed into the computer and placed into a record, which would be similar to a card in the box.  The 
records are arranged alphabetically in the file just as interest cards would be arranged alphabetically in a 
box.  Each piece of the individual’s information is stored in fields such as, first name, last name, etc.. 

Team Codes.  Many times there will be more than one pastor visiting the names in the file.  The team 
code is a powerful tool, which helps to organize the names into groups.  Each team is assigned a code 
number (01-20).  The names are divided between the teams and the appropriate team code number is 
recorded in the file.  The program will automatically print lists of names by team code; that is, each team 
will receive a list consisting only of the names that have been assigned to them.  There is an additional 
feature, which allows the assigning of the team codes to be made automatically according to the zip code. 
After the zip codes have been assigned to team codes, each new name will automatically be given the 
proper team code. 
Reserved Registration Numbers.  The easiest way to enter the attendance each night is to use the 
registration number.  You should have some means of registering each person with a unique number.  We 
use the sample registration packet included with this manual as an example. 
 Occasionally, someone will turn in a card with no number, or a card they borrowed from someone else.  
In this case you would enter the name with an assigned registration number.  You can select any unused 
number; however, the best to way is to reserve a block of numbers to use, and let computer assign them 
automatically. 
You simply select a block of numbers that will not be used on the registration cards.  For example, if 
your registration cards are numbered from 1000 to 6000, then reserve numbers 9000+.  These reserved 
numbers will be automatically assigned when needed.  For more information, see “Reserved Numbers” in 
the Database Management section (page 21). 

Interest Levels 
Track’em supports the following interest level codes. 
 A- A positive name that will probably be baptized 
 B- A positive name that needs a little persuasion 
 C- Positive, and could be baptized but has questions 
 D- Negative 
 E- Open for any special use you desire 
 F- Future study but not now 
 G- BAPTIZED!!!  Why “G?”  Because it comes after “F” 

Option to Show Decisions in the Attendance Record will put the decision made in place of the meeting 
number on the attendance record.  If a person makes a decision for the Sabbath on the 7th night, the 
attendance record will show an "S" in place of the "7." For Example: 12-4C6S-90-B345K7U901234. The 
advantage of this option is that you can tell when a person makes a decision.  The disadvantage is that it 
tends to make the attendance record harder to read.  We suggest you leave this option off unless you 
really feel that you need that information. 
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How to Get Started 

Using this Manual 
The Manual is divided into five different parts: 

• Introduction and Overview 
• Reference Manual - Describes each option of the program. 

• Tutorial - A step-by-step description of how to use the various features of the program. 

• Strategy - “Revelation Now Crusade Visitation Strategy” is a detailed strategy we use in visitation 
and is designed to help you get the maximum benefits from the program. 

• Appendix - Contains samples of Visitation Report Forms and the cards, which we use to collect the 
information each night along with other materials, which might be helpful. 

You should read this introductory and the reference sections first.  Then work through the examples in 
the entire Tutorial before actually using the program in a crusade. 

Installation 
1. Insert the program diskette #1 into the floppy disk drive. (Or if you downloaded Track’em from the 

Internet, move it into a new folder, unzip it and double click setup.exe.  You can skip step 2) 
2. Press the Start Button and Select “Run" then type A:Setup.exe. 
3. The computer will suggest a new folder called   \Trackem   on the drive that you select.  The install 

program will copy all of the essential files to that folder.  Use the suggested folder 
4. When installation is complete, a “Track em” Icon will appear in the Programs menu on the start button 
5. Installation will create a folder called  \Trackem\Data for all Crusade files to keep them separate 

from the program files.  It is highly suggested that you use this folder. 

Getting Started 
1. Start Track’em by clicking the Start button then the Programs button and the Track’em icon. 
2. You will see a splash screen with two option buttons. The load last crusade button is disabled. You 

must either create a new file or change to an existing one." Since there is no existing crusade file, you 
will have to create a new one.  Click the Select/ New Crusade Button. 

3. Select the folder for your data files and click the Button. 
4. You will see an open file dialog window.  Select the folder that you have set up for your crusade data 

and enter an appropriate name for the file in the file name window.   Do not type any extensions to 
the file name, as they will automatically be assigned.   You will be able to change the name that is 
used as the heading of the reports if you desire.  This is the file name. 

5. You will see a window saying that there are no records in the file and you must add records. 
6. The next window will ask for the meeting number.  Accept the number 1. 
7. Now you can begin entering data for those attending the meeting. 

How to Remove Track’em from your Hard Disk 
Use the remove software program found in the Control panel to remove Track’em. 
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Information Found in Each Record 

1. Registration ID Number.  A four-digit number, assigned to each individual attending, which is used 
to update the information on their record.  For example, each night the ID number is typed into the 
computer and each record is updated for attendance.  You should have a system for getting the 
registration number each night (see Appendix:  Gathering the Data). 

2. Name, Address Phone, including zip codes which can be used to divide the names by territory. 
3. E-Mail Address if supplied can be exported to a bulk E-Mail Program for sending E-Mails to 

Interests in your files. 
4. Mail List Information.  An indicator which allows you to select which names should be entered on 

the mail list.  For example, you would select only one individual from each address to send letters to.  
The program prints labels only to the names on the mail list. 

5. Age Group.  Enter from registration card or visitation reports. 
6. Religious Preference. Enter from registration card or visitation reports. 
7. Advertising Survey.  Information concerning the method of contact with your meetings each person 

had.  You can record whether or not they received a handbill in the mail or heard the radio or TV 
spots, etc.  In addition, you can record those receiving a personal invitation and enter the name of the 
member or friend who invited them. 

8. Attendance Record.  Indicates a complete record of the nights attended and the nights missed. 
9. Last Meeting and Total Meetings.  Track’em automatically calculates this.  You cannot edit it. 
10. Team Code.  A two-digit number (01, 02, etc.) which identifies each visitation team leader.  The 

names are all divided up by team codes so that team #01 will only get a print-out of the names for 
which he is responsible. 

11. Level of Interest.  A one-letter code indicating the degree of interest the person has, A, B, C, D, or F 
for future and G for those baptized. 

12. Decisions.  Includes 9 major decisions: 
A. Accepts Christ F.  Health Problem 
B. Accepts the Sabbath G. Second Advent 
C. Keeps the Sabbath H. State of the Dead 
D. Sabbath Work Problem I. Desires Church Membership 
E. Desires Baptism J. Attending Baptismal Class 

13. Visitation Record.  Record up to four visits giving the day and type of visit, such as Home, Meeting, 
or Phone. 

14. Baptism Interview /Class.  This is a check box for you to check when they have made an 
appointment for a baptism interview or enrolled in your baptism class. 

15. Baptized or POF.  Check here when they have been baptized or accepted by Profession of Faith. 
16. Baptism Date.  The date that the interest was or will be baptized. 
17. Birth Date:  You can enter up to 8 characters to specify the birth date.  It will be displayed on the 

Baptism list for the clerk’s use. 
18. Map Code.  The page and coordinates of the address on a map.  If you enter a map code, the 

attendance printout will display it in place of the zip code. 
19. Notes.  A field to write specific information, such as location of the house, map code, family 

information, etc.  You can enter up to 100 characters. 
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An Overview of the Program 
“Track’em” will allow you to create, edit, update and print various reports to assist you in a powerful 
method of managing the evangelism interest names.  The names can be classified by attendance, level of 
interest, team codes, decisions made.  It also includes important information such as religious preference, 
age group, and how often the interest has been visited.  The following is a brief summary of the 
capabilities of the program.  A detailed explanation of each program option follows in its own section. 

Navigating Through the Program 
Most of the features can easily be accessed from the following menus on the Edit Screen: 

 
Files 

− Backup Data 
− Restore Data 
− New Crusade 
− Change Crusades 
− Erase Files 
− Merge Files 
− Compact Data 
− Fix Files 
− File Information 
− Preferences 

− Exit 
Edit 

− Undo Changes 
− Edit Mode 
− Zip Mode 
− SDA Names 
− Zip Code Files 
− Enter Visits 
− Global Search 

Records 
− Add Records 
− Copy Records 
− Delete Record 
− Previous Record F-7 
− Next Record F - 8 

Attendance 
− Attendance Update 

Preview File 
− Alphabetical 
− Attendance 
− Alpha by Team 
− Attendance by Team 
− Baptisms 
− Statistics 

Print Records 
− Meeting Cutoff Point 
− Alphabetical 

Print Records Continued 
− Attendance 
− Alpha by Team 
− Attendance by Team 
− Print Baptisms 
− Priority Interest List 
− Mail Label 
− Interest Card 
− Baptism Dates 
− Pre-crusade Interests 
− Write Mail Merge File 

Filters 
− All Names Alpha 
− Attendance 
− Baptisms 
− Interest Level 
− Religion 
− Zip Codes 

Help 
− About Track’em 
− Registration 

 
 

 
Four  ways to activate a Menu Item: 
1. You can simply click the Menu item with the left mouse button. 
2. You can select menu items from the keyboard.  Each menu option has a letter which is underscored.  

Simply press Alt key to select the menu bar and then type the underscored letter displayed in the 
menu item to view the drop down box.  Press the underscored letter in the drop down box to activate 
that item.   

3. In addition, some of the menu functions have a hot key assigned to it for example: look at the menu 
for add a record under the records menu.  Notice the Ctrl + A designation.  You can press the hot key 
from any place in the program to activate that menu object. 

4. You can call up the Edit Menu by right clicking on the screen in a place that does not have an 
information box. 
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The Menu Options 
 

The File Menu 
Backup Data- Backup the current crusade to a floppy disk. 
Restore Data- Restore the information from a floppy disk. 
New Crusade-  Create a new data file for a new crusade. 
Change Crusades- switch to a different crusade.  
Erase Files-  Remove old crusade files from the hard drive. 
Compact Data- As with any data base, the file tends to expand in size when you add and delete names.  
For this reason you should periodically compact the database to compress and repair the data files.   
Merge Files-  Merge data from one file which was entered on a different computer into the current file.  
Preferences-  Allows you to;  1)change the Crusade name and Crusade Date that appears on printed 
reports,   2) Change the Last Meeting Number, 3) Reserved Numbers, 4) Direction to count reserved 
Numbers, and the 5) Option to indicate Decisions made on the attendance record. 
Exit the Program.  Returns to the Windows 95 desktop. 

The Edit Menu 
Undo Changes- reverses the edit changes you have made to a field. 
Edit Mode-  Allows you to search through the entire file, view each record one at a time and edit any 
records you would like to change or update.  This option only appears in the Add Mode and will switch 
back to Edit mode. 

SDA Members.  Allows you to enter the ID number and name only of the church members.  This is very 
helpful in multi-church meetings where you may not know all of the members by name.  One of the 
biggest problems each night is what to do with the cards of those who are not entered in the file.  If they 
are not members, then you will want to enter them into the file.  However, if they are members, then you 
will not want to enter them in.  This option will enable the computer to tell you if an ID number belongs 
to a member. 

Zip Codes.  Allows you to assign each zip code to a visitation team.  The computer will automatically 
assign all existing names in the respective zip codes to the proper team, as well as automatically assign 
all new names as they are entered, unless they are overridden with a manual assignment.  

Enter Visits.  Allows you to quickly update the visitation reports turned in by each visitation team. 

Global Search-  Will allow you to search for any word or number in the Name, Address, City, State, and 
Zip Code, E-Mail or Note fields. 

The Records Menu 
Add Names.  Enter new names into the existing file, along with all of the information found on the 
registration card. 

Copy Record-  Will copy all of the information from one record into a new record with the exception of 
the record number,  first name and age.   This feature is useful if a husband and wife are on the same card 
and they are both going to be baptized.  In order to get a good count of baptisms and good interests you 
should transfer one to a separate record.  Track’em will automatically assign a reserved registration 
number to the new record.  You must add the first name and age. 
Delete Record-  Remove the record from the file.  
Previous  Record-  Return to the Previous Record in the file.  The Shortcut key is {F7} 
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Next  Record-  Advance to the Next Record in the file. The Shortcut key is {F8} 

The Tools  Menu 
Attendance Update:  Update the nightly attendance records by entering the four-digit registration number 
turned in each night.  You can automatically enter any decisions made that night.  In addition, you can 
edit the individual card if necessary. 

Team Assignments- Allows you to assign names to a worker team automatically by zipcode.  All names 
in an assigned zipcode will be given the appropriate team number automatically.   
Count Team Names- Gives an exact count of the number of names assigned to each team. 
Mark all Displayed Records- Allows you to instantly mark for printing or exporting all records displayed 
after applying a selected filter.  For example if you want to write a mailmerge letter to all who missed a 
certain night, you can select the appropriate filter, mark all names and then export the marked names to a 
mail merge file.  To remove a name from the list, simply unmark that name. 
Clear Markers- will clear all marked records. 
Clear Interest Card Flag- Trackem will only print interest card labels one time for each name.  If you 
want to reprint interest card labels then you can use this feature to reset Trackem to do it. 
Open Excel Charts- Use this feature or the button on the button bar to look at all of the chart options 
available in the special Stats package.  You must have Microsoft Excel in order to use this feature. 
Mail Merge File- This option will export a mail merge file for use with your word processor program. 
Export to E-Mail File- This feature will allow you to export selected E-Mail addresses to a text file 
which can be used by E-Mail broadcast programs such as World Cast , to send an E-Mail to everyone 
on your list who has supplied an E-mail address. 
Export to Street Atlas Maps- This feature will allow you to export selected addresses to DeLorme’s 
Street Atlas USA. 
Export to Pre-Meeting File- Use this feature to export your data from a pre-meeting interest file to a 
separate file that Trackem uses to automatically fill in the names of prior interests who attend the 
meeting. 
After typing the first and last name Trackem will search the pre-meeting file for a name match.  If found , 
it takes all of the information from the pre-meeting file (phone, address, etc) and enters it automatically 
into the current record.  
To usethis feature: 

1. Start a pre-crusade file with the exact same name as the crusade but add the prefix "pre_"  
(underscore). For example for a crusade file named, "Seattle" you would use (pre_Seattle) as the 
file name for the pre-meeting interest file.   

2. Enter interest names into the pre file.  
3. When you are ready to add names into the meeting file, create the new file for the meeting by 

sellecting the export to pre-meeting file option from the tools menu.  This will prepare a special 
file for data entry into Trackem for the main Crusade file.   

4. Enter names as usual into the meeting database.  When you press enter or tab after typing the last 
name, Trackem will look for a match and if found, will automatically enter the information. 

NOTE: You must name the crusade file exactly as shown above for this feature to function properly.   
The rest is automatic. 

The Preview  Menu 
These options allows you to preview all of the names in the file on the screen.  Preview contains a very 
powerful feature.  When you are viewing the names on the screen, you can simply click your mouse on 



 15 

any name and you will see that record in edit mode.  To return to preview, you simply select it from the 
menu again or you can use the hot key {Ctrl + V}. You can arrange them in two different orders: 
Alphabetical- All names arranged in alphabetical order 
Attendance- All names arranged by attendance.  The first group of names will include those who 
attended the last meeting.  Then those who have not returned since the meeting prior to that, on down the 
list until the final group consisting of those who have not been back since the first night. 
In addition you can look at the names by the team numbers. 
Alphabetical by Team Number- All names assigned to a team arranged in alphabetical order and printed 
on a separate page for each team. 
Attendance  by Team Number-  Same as above but arranged by attendance. 
And you can preview the: 
Baptism List- The names of those who have been baptized. 
Statistics- You can view the following information from this option: 

• Nightly attendance, and the percent of opening night attendance. 
• Total Number of names, Names on the mail list, Baptisms and A, B and C names. 
• Number of people registered from each denomination 
• Number of people attending from various advertising methods  
• The number of people making various decisions 

 There is an option to print out the statistical information on paper. 
 
Important note:  While viewing the selected list, you can click the mouse on any name in the file to go 
the record for that name or you can update the attendance directly from that screen.  You can make any 
changes to the record or even move it to the SDA File, but you will not be able to search for other records 
or use the navigation aids to move to other records.  You must return to the Preview screen by means of 
the Return to Preview"  which replaces the search box at the top of the screen.  Then close the preview 
screen in order to return to the Edit Mode. 

The Print Menu 
Print Records-  Provides a printout from the printer of all names arranged either Alphabetical or by 
Attendance as mentioned above for preview as well as by Team numbers.  The Attendance printout is the 
main one to use for tracking the names for daily visition. 
Interest Level: Names arranged by Interest Level beginning with A continuing through C, followed by 
those who were baptized. 
 A-  Positive name that will probably be baptized 
 B-  Positive name that needs a little persuasion 
 C-  Positive, and could be baptized but has questions 

G- BAPTIZED!!!  
 

Baptized Names:  a list of all who have been baptized along with their baptismal dates and birth dates. 
Mail Label- Will print out the names on the mail list, arranging by zip codes for Avery 5160 labels.  You 
can select to print labels for all names, active attending names, priority interest levels, and those who 
have been baptized. 
Interest Card- Will print labels that can be attached to 4x6 cards for visitation. 
Statistics/Charts.  Provides a print-out of various statistical data, including:  Total and percentage (based 
on the opening night) names attending each night, total active names in the file, breakdown of names and 
baptisms by religion, age and advertising and a graph of nightly attendance. 
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Decisions.  Will print out a list of all names making a particular decision and can be arranged either by 
team code or alphabetically. 

Team Reports 
Master List.  Each team receives all of their assigned names, listed alphabetically. 
Attendance.  Lists each assigned interest present beginning with the most recent meeting.  
Subsequent nights will list those who have stopped coming on those nights. 

Zip Assignments.  Lists all zip codes along with the visitation teams assigned to that zip code. 

The Filter Menu 
This menu is another powerful feature that will allow you to view a selected set of records in a selected 
order. When you select a filter other than “All Names Alpha,” you will see the following: 

• You will be asked to set the meeting cutoff number. 
• The “Show All Names” button will appear.  Clicking that button will activate the “All names Alpha 

Filter and restore the screen to it’s normal Edit mode. 
• The filtered field will be highlighted. 

All Names Alpha-  will allow you to view all of the names in the file arranged in alphabetical order.  
This is the main filter that you will use.  After using any of the other filters you should select this one. 
Alpha Filtered-  This filter will arrange all names by attendance similar to the attendance printout above. 
Team Code Filtered-  This filter will arrange the names alphabetically by team code. 

Attendance-  This filter will arrange all names by attendance similar to the attendance printout 
above. 

Baptisms-  This filter will select only the names that have been baptized.  (Interest level G) 
Interest Level- This filter will select only the names that have an interest level of A, B or C and arrange 
them by order of interest level similar to the information in the preview by interest level option discussed 
above.  That is, all A names will be followed by all B names and then C names.  The Baptized names will 
be at the end of the list.  Since this filter does select names from the file they will not all be present.  
Religion all names arranged by religious preference indicated on the registration card. 
ZipCode   will give you all names sorted by zipcodes. 
Baptism Dates:  will select only those names that have a baptism date set. 
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New Crusade 
Create a brand new database for you to set up the files containing all of the records of the persons 
attending the meetings.   Create the files by completing the following steps: 

1. Select the New Crusade option from the File Menu 
2. Enter the File Name:  A pop-up box will appear and you should type the Crusade File Name (usually 

the current city) and press {ENTER}. 

• This is the file name for saving it to the disk.  Later you will be asked for the name that you want 
to appear on all reports. For Example:  If you are having a meeting in Bremerton, WA you could 
use “Brem” or “Bremert”.  This is not satisfactory for a report title.  In the next step below you 
will be given the opportunity to enter a more descriptive name like “Bremerton, WA” for the 
reports. 

• If you enter the name of a previously existing file, you will get an error message and be prompted 
for a different name.  Otherwise you will overwrite all of the data in that file.  If you want to use 
the same name as a previously existing file, you must remove the file from the disk first, using 
“File Manager.” 

• The program will automatically assign the extensions, to your file name.  Example:  File Name 
“brem” will appear as brem.dta, brem.idx, brem.inf. and etc. on the disk. 

3. A window will display the disk and path that the files will be named. If this is what you want click 
'OK.' 

4. If it is not the folder that you want, then click 'NO.' 
5. You will see the 'Maintain Files' menu.  Select the drive and folder that you want and click the 'New 

Crusade' button.  Do not try to enter a file name.  The backup files will automatically be assigned the 
same name as the original files. 

6. Next enter the Crusade name as you want it to appear on the printed Reports.  For example, you can 
enter Bremerton, WA.' 

7. Next enter the Crusade date.  This is not the date printed on the daily reports.  They will have the 
current date.  This will simply serve as another means of identifying when the meetings were held. 

8. You will be told that you need  to enter the new records in the database. 
9. Next you should select the meeting number.  The default is one.  This will mark the attendance for 

each name entered as being present on the first night. 
10. Begin Entering the names. 

Change Crusade 
This option allows you to switch to various crusade files that are already present on your disk. 

1. Select Change Crusade from the File Menu 
2. Select the Drive where the files are located 
3. Select the path for the files. 
4. When the file name that you desire is displayed, select it and click the 'Change' button. 
5. You will see a message saying that the file has been loaded successfully.   

Backup Files 
Make a copy of your data file on a floppy disk or to a different folder on the hard drive.  The backup files 
will have the same name as the original files therefore you cannot back up the files to the same folder.  
You should make a backup copy, each time you do extensive work on the file.   

It is best to use two diskettes, one for odd nights and one for even nights to avoid losing more than one 
night of work if both the data and the backup diskette should be bad. 
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1. Select Backup Files option from the File Menu 
2. A window will display the disk and path that the files will be backed up to.  The default will be the 

last back up.  If this is what you want click 'OK.' 
3. The files will be backed up.   
4. If it is not the folder that you want, then click 'NO.' 
5. You will see the 'Maintain Files' menu.  Select the drive and folder that you want and click 'Backup 

Files.'  Do not try to enter a file name.  The backup files will automatically be assigned the same 
name as the original files. 

6. You will see a message saying that the files have been backed up successfully. 

Restore Data 
Allows you to copy data stored on a floppy diskette to your hard dirve the.  If somehow you lose the data 
on the hard drive, you can recover it from a floppy diskette.  In addition, you may work on a lap top and 
want to update the data onto your desk top computer.  This feature makes that possible. 

Remember that this option will  overwrite the data files on your hard disk when you copy from a 
floppy to the computer’s hard disk.  Be sure that your floppy disk is the version that you want. 

1. Select Restore Files option from the File Menu 
2. A window will display the disk and path that the files will be restored from.  The default will be the 

last back up.  If this is what you want click 'OK.' 
3. If it is not the folder that you want, then click 'NO' and follow the same procedure as above for 

backup files. The restore files will always have the same name as the original files. 
4. You will see a message saying that the files have been restored successfully. 

Erase Old Files 
This option will allow you to remove old crusade files from the hard drive.   
1. Select Erase Files option from the File Menu 
2. Select the disk and path that the file that will be erased.  
3. Click the Erase File Button  
4. A warning message will appear.  If this is what you want click 'OK.' 
5. Another "Last Chance"  warning message will appear.  If this is what you want click 'OK.' 
6. The files will be erased. 
7. You will see a message saying that the files have been erased successfully. 

Merge Two Data Files 
This option will allow you to have two or more people entering the initial data on different computers 
and then combine those files into one database. 
1. If you have not already started the new file, designate which computer will have the Master File and 

create a New File (see New Crusade above,p.17).  Example, you may name the file Auburn. 
2. Create a new file on the second computer.  Name it Auburn2. 
3. Divide the new names and enter them on the two (or more) computers. 
4. Back up both files onto a floppy disk. 
5. Insert a floppy disk with the Auburn2 file into the drive on the computer with the master file. 
6. From the File Menu, click the “Merge File.” button. 
7. Select the proper disk, folder and file name; then press “OK”. 
8. A message box will summarize the merge.  If it is correct, press “OK”.  If it is not correct, press 

“Cancel”. 
9. All of the information from both computers is now contained in the one master file, Auburn. 
Special Notes about Combining Two Files 
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• You cannot have Duplicate Registration Numbers.  Should there be a duplicate on the file being 
merged into the computer, the program will automatically reassign a registration number from the 
reserved numbers block.  See “Begin Reserved Numbers,” page Error! Bookmark not defined.. 

• Visitation team Names from the file on the floppy disk will not be merged into the existing file.  Be 
sure to make all team code assignments on the main program.  It is safest to just enter new names on 
the floppy files and wait to do any assignments and editing until they have been merged. 

• Do all Attendance Update work on the Master file only, to avoid loss of data. 

Merge Attendance Info from Another Computer 
This feature will allow you to update the attendance on multiple computers and then merge the updates 
into the master file.  It will also give you the option to add any names from the remote computer into the 
master file. You must exercise great caution in using this feature and always back up your master file 
first.. 
1. Back up the Master File to the same floppy drive you will be using to update the information. 
2. Restore or copy the most recent Master File you have just backed up, to each remote computer.   

This is critical!!  Failure to carry out this step will update your master file with outdated 
information from the remote file. 

3. Update the attendance on the remote computers. 
4. Insert the floppy disk containing the updated attendance file from the remote computers into the 

computer containing the main database. 
5. Select Merge Attendance Information from the Files menu. 
6. If any new names are found in the file on the floppy disk, it will ask if you want to merge them into 

the main data file. 

Special Precautions to take: 
1. When you update the attendance on a record in the remote file, it will copy all of the information 

for that record into the main file.  This allows the operator on the remote to make any changes to the 
record and those changes will be updated to the main file.  For this reason yu must have an up to date 
back up file before beginning to update the info on the remote. 

2. This option will look at the last meeting number in the main file and then search the remote file for 
names whose last meeting matches the last meeting number in the main file.  This means that you 
must always update some names in the main file (at least one) or change the last meeting number on 
the “Preferences” option from the File Menu.  For example: If you update the remote computer with 
names for night #8 but the main computer only has attendance for night #7, the attendance for night 
#8 from the remote will not be added to the main file. 

3. If you add new names into any of the data bases, remote or main, you must be sure that no one else 
has that new registration number.  This is not a problem as long as the new names have unique 
registration numbers.  It can be a problem if someone turns in a card with no number or someone 
elses number and you use the auto assign (press the tab key in an empty Registration Number field).  
This will automatically assign a number from the reserved numbers allocated for that file.  For this 
reason, you will need to insure that each remote computer has a unique set of reserved registration 
numbers for auto assigning.  For example:  Assign a reserved block on the main computer from 9999 
down.  Then on a remote, assign 9700 down, and on the third, 9400 down, etc. 

Compact the Database 
A database will gradually enlarge as you add records and delete them.  Even though the record is deleted, 
the database still reserves the space it was holding.  For this reason a data file must be Compacted 
periodically.  Caution!  When you compact the database, you will remove the deleted information from 
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the computer and you not be able to restore those names to the file.  It is not recommended that you 
compact the database unless the file gets too large. 

Fix the Database  
Occasionally some of the files and indexes may become corrupt.  This option will repair many data base 
problems.  If you are having any problem with the program, run the Fix Option by simply selecting it 
from the Files menu. 
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This option from the files menu allows editing the: 

• Crusade Name.  This is the name that appears in the heading of each report. 

• Meeting Date.  A reference to the time of the meetings.  The reports will show the actual date. 

• The Last Meeting Number.  The last meeting number is used for printing various reports, and as a 
default entry for attendance updates.  It will be saved as the highest meeting number you enter either 
from the add names form or from the attendance form.  It is possible to inadvertently enter an 
incorrect number which is higher than the current meeting.  For example, on meeting number 3 you 
inadvertently enter 8.  The number 8 will be stored as the last meeting number and it will be the 
default for the attendance and add names forms until the ninth night when it changes to nine.  You 
can change the last meeting number here so your defaults will be correct. 
Various Track’em options use a meeting number to select reports or to enter attendance.  They use the 
last meeting as a default.  For example, if you enter new names for meeting number seven, the last 
meeting number will be 7.  When you update the attendance cards and enter the attendance program, 
you will be asked for the meeting number.  Seven will be the default so that you simply press 
{ENTER} to accept it.  Or if you want to do a different night, you can change it. 

• Reserved Numbers.  This feature allows you to designate a block of numbers for the automatic 
registration assignment feature.  There are two places that use automatic numbers. 

Add Names:  If you simply leave the Registration Number field blank and press enter, the 
program will automatically assign a number. 
Merge Files:  When merging data from a floppy to your computer, the program will 
automatically assign a number from the reserved numbers to any duplicate Registration Numbers. 

• Setting the Reserved Number 
Select a block of numbers at the top end or bottom end.  The highest number allowed is 9999, the 
lowest is 0000.  It is best to set a top number and count up or a bottom number and count down. 

For example, if your ticket books or registration cards do not use the 9000 or above numbers, then 
set the “Begin Reserved Numbers” at 9000 and the Direction to Count as “Up.”  The first time you 
use the auto-assign feature, it will assign the number 9001.  The second time it will use 9003, etc.  In 
other words, it counts up.  If you will not be using any numbers below 1000, you can set the “Begin 
Reserved Numbers” at 1000 and the Direction to Count as “Down.”  The first time you use the auto-
assign feature, it will assign the number 0999.  The second time it will use 0998, etc.  In other words, 
it counts down. 

• Direction to Count:  Simply select either down or up.   

• Show Decisions on Attendance Record will put the decision made in place of the meeting number on 
the nightly attendance record.  If a person makes a decision for the Sabbath on the 7th night, the 
attendance record will show an "S" in place of the "7." For Example: 12-4C6S-90-B345K7U901234. 
The advantage of this option is that you can tell when a person makes a decision.  The disadvantage 
is that it tends to make the attendance record harder to read.  We suggest you leave this option off 
unless you really feel that you need that information. 

• Turn Sound On/Off-  Check the box to turn the sound off.  

• Show Toolbar Button Labels- Displays the names of the buttons under the button bar. You can turn 
this feature off here if you do not want the screen to cluttered.  

• Sabbath Morning Meetings.  This gives you the opportunity to enter the meeting numbers for your 
Sabbath morning meetings.  When these numbers are entered, the printout will designate in the 
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heading that it is a Sabbath Morning meeting. This is helpful for visitation teams who may not be 
familiar with your lineup. 

• Adjust the Position of Mail Labels.  If your mail labels are not quite in the proper location for your 
printer, you can adjust the position slightly at this point. 

• Decisions Tab.  You change the decisions and decision codes in Track’em, but be aware of the 
following  
(1) Changes to decisions will be reflected on all records that had previous decisions entered.   For 
example: If you change Baptism to Tithe, all names previously marked as a decision for baptism will 
be shown as a decision to Tithe.  Make changes before you begin entering decisions on the records. 
(2) The Visitation Report will track the number people who marked Sabbath on their cards and have 
been visited. It will only track the Accepts the Sabbath Visits.  The same applies to Accepts Christ, 
which is used to track Gospel Visits.  If a person comes forward in an altar call, mark Accepts Christ.  
Then you can track how many of them have been visited by using the Visitation Statistics Report. 
(3) Trackem uses the decision “Unite” to track those who have decided to join the church.  It uses it 
for example in determining the difference between baptisms, profession of faith and rebaptisms.  If 
you check baptism and unite, they will be recorded as a baptism.  If you check baptism and do not 
check unite, they will be marked on the report printouts as a rebaptism.  If you mark Unite but not 
baptism, they will be recorded as a profession of faith.  
Track’em will not allow you to change the “Accepts Christ,” “Accepts Sabbath” or “Unite” 
decisions.   

• Religion Tab, allows you to change the church preferences Trackem keeps track of. 

• Sermon Titles.  This feature allows you to enter you sermon titles so they will appear in the heading 
of your attendance reports.  This is useful for the team members who do not know your sermon 
lineup.  Use Short titles that are descriptive of the message.  These are not the catchy titles used for 
attracting the crowd but for use by your visitation teams.  For example, you should use “The 
Sabbath” instead of something like “Adam’s Mothers Birthday.”   
 
Also in light of the above information for the Decisions, your first sermon with the Word “Gospel” in 
it will be the one used to track the Gospel Visits and the same for the word Sabbath.  If you preach 
the Gospel and invite people to come forward and accept Christ, then the title of that sermon should 
have the word Gospel in it.  Then Track’em will look for those people that came forward to accept 
Christ on that night to see who needs to be visited.  It will count the number of Gospel visits made by 
each team.  The same applies for the Sabbath.  Be sure you have the word Sabbath in the title of the 
first sermon preached that asks for a decision on the Sabbath.  Track’em will count the number of 
those interests who have or have not been visited after that night. 

• Visitation Team Names.  You can enter the names of your visitation teams as well as their phone 
number.  This will appear at the top of each team report. 

 
The first time you run Track’em after installing it on your computer, it will use the default values for 
each field (Including my sermon titles).  After you make your own changes, subsequent New Crusades 
will use your information.  Just be sure you leave the last Crusades data on the computer.   
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Add Names 
 
 
The Add Names option will allow you to enter the name, address and other information to the individual 
records of the database. 

The procedures are fairly self-explanatory and the following information will facilitate the process.  Be 
sure to read the instructions in the Interest Committee’s Guide (Appendix page following the Tutorial) to 
arrange the names in the best way in order to make computer entry as efficient as possible and take 
advantage of the special features of the program. 

Select Add New Records from the Records Menu or the New Names button on the button bar. 

Meeting Number.  This number will be the first meeting number marked on their attendance record, and 
it should be the number of the first meeting they attend.  For example, on the opening night of the 
crusade, this number should be one and all names entered will have the meeting number one marked as 
present.  On the following night, you should enter the number two here, and so on. 

• Enter all team codes as 00 unless you have a specific team to assign that name to.  Using the 00 will 
activate the automatic team code assignment feature that assigns names according to territory.  
(Explained in the section on Assigning Team Codes.) 

• Type the information followed by {ENTER} or {Tab}. 

• Enter the registration number correctly.  The program will not allow you to enter the same 
registration number twice. If you attempt to enter a duplicate number you will see a warning message 
and return to that field.  If you would like to enter a reserved number automatically, you can simply 
leave this field blank and press {ENTER} or {Tab}. 

Reserved Numbers 
You can reserve a block of registration numbers that will be automatically assigned when needed.  For 

more information, see “Reserved Numbers” in the Database Management Section (page Error! 
Bookmark not defined.). 

• You can type the First Name, Last Name and City, using upper and lower case letters, as you want it 
to appear.  The program will automatically change the first letter of each field to uppercase for Name 
and City.  If no name, etc., is given, press {ENTER} and “NIF” will be assigned to that field. 

• Zip code.  The reason the Zip Code is listed before the City and State is that the program has an 
automatic feature. The first time a Zip Code is entered, you must enter the City and State.  
Subsequent entries of that same Zip Code will automatically enter the City and State and advance the 
cursor to the phone number field.  You can change the city if a Zip Code has more than one City. 

• The State may be entered in either lower or upper case letters but the computer will automatically 
change the lower case to upper. 

• If you have no information to enter, simply press return and the letters NIF (Not In File) will be 
entered automatically. 

• Phone Numbers may be entered using a dash (-) if you like, but the program will automatically enter 
the dash if you choose to omit it.  Example:  Entering the number 8860771 followed by {ENTER} or 
886 0771 will appear as 886-0771. 

• Repeat Function is a special feature which enables you to enter the same information that was 
entered for the previous name without retyping it.  For example, if you entered John Smith’s 
information into the file and the next name is his wife, Mary Smith, enter her registration number and 
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first name.  Then, instead of typing the last name and the remaining information, which will be 
identical to her husband’s, press the {F2} key and the information from her husband’s record will be 
automatically entered.  Continue using the repeat function until all information is added.  This helps 
you avoid retyping the address, City, State and Zip Codes if the names are presorted.  For this reason 
it is to your advantage to sort the names by families, cities and finally zip codes before typing the 
information into the computer. 
 
You can enter the data even faster if you press {F3} instead of {F2}.  The {F3} key will 
automatically fill all of the fields down to age without having to repeatedly press the key. 

• Correcting Errors.  You can go back to any field and correct errors using the mouse.  
Once you have entered the advertising information, the {Save and New} button will be highlighted. 
You can press {Enter} to save the record and enter another name.  You do not have to take your hand 
off of the keyboard to use the mouse.  Or you can make any edits or changes to the record first, then 
go back to the {Save and New} button.  If you want to edit the previous record, you must click “Save 
and Exit” at that point. 

• Mail List.  Click in the box or press the {Space Bar} then {Tab} if the name is to be entered on to the 
mail list.  The Mail List program will only type out labels to those names that are entered on the mail 
list.  This prevents sending two letters to the same address.  See the “Interest Coordinator’s Guide.” 

• Age.  Simply enter the first number of the age and it will be assigned to the proper group.  You 
should enter a 1 for anyone less than ten.  For example, if an individual were 9, and you entered 9, it 
would be assigned to the 60+ group.  If there is no age given, press {ENTER} and “NIF” will be 
assigned to that field. 

• Religion.  The pop-up box appears when you enter this box.  Simply select the appropriate letter.  Be 
careful to notice the difference between “No Church” and “UnSpecified.”  “No Church” means they 
have no church preference; “UnSpecified” means they may have a church but just didn’t indicate it. 

• Advertising Inf. is entered by typing the appropriate highlighted letter, which corresponds to the 
information marked on the registration card.  If you enter a letter not included on the list, it will be 
ignored.If you enter a personal invitation (I), you will be asked the name of the person sponsoring 
them.  For a shortcut you can enter the sponsor’s name directily.  Type the letter “I” followed by a 
dash with the name of the sponsor.  For Example “I-Jones” 

Automatic Pre-Meeting Interest Designation Entry 
If you enter a Personal Invitation on the Advertising field and the night is number "1" then Track'em 
will automatically enter a P into the advertising field for Pre-Meeting Interest.  This is based on the 
assumption that all invitations are by members for the first night.  Obviously this will not be perfectly 
accurate because some interests who come from the advertising will invite others to go. It is an 
approximation and can always be adjusted manually  

 

• After entering the Advertising, the {Save and New} button will be highlighted. You can press {Enter} 
to save the record and enter another name.  Or you can select the {Save and Exit} button to save that 
record and exit from Add Mode to the Edit Screen.  Or you can click the {Cancel and Exit} button to 
exit from Add mode and you will return to the Edit mode.  Caution, when you click the {Cancel and 
Exit} button, you will lose any information typed into the last record. 

Importing Names from a Pre-Meeting File 
Track’em allows you to create a pre-meeting interest list and import those names into the data file as you 
enter new names into the file.  Before entering the names into your main meeting data base you must 
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export your data from the pre-meeting interest file to a special file that Trackem uses to automatically fill 
in the names as you type, of prior interests who attend the meeting. 
After typing the first and last name Trackem will search the pre-meeting file for a name match.  If found, 
it takes all of the information from that record in the pre-meeting file (phone, address, etc) and enters it 
automatically into the current record.  
To use this feature: 

1. Start a pre-meeting interest file with the exact same name as the crusade but add the prefix 
"pre_"  (underscore). For example for a crusade file named, "Seattle" you would use 
(pre_Seattle) as the file name for the pre-meeting interest file.   

2. Enter interest names into the pre file.  
3. When you are ready to add names into the meeting file, select the export to pre-meeting file 

option from the tools menu.  This will prepare a special file for data entry into Trackem for the 
main Crusade file.   

4. Create the new file for the meeting using the proper name according to step 1 above (Example: 
“Seattle”). 

5. Enter names as usual into the meeting database.  When you press enter or tab after typing the last 
name of each individual, Trackem will look for a match and if found, will automatically enter the 
information.  The first and last name must be a perfect match in order for this option to work. 

 
NOTE: You must name the crusade file exactly as shown above for this feature to function properly.   
The rest is automatic. 
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How to Handle SDA Church Members 
 

Track’em allows you to enter only the registration number and name of the church members attending in 
a special church member file.  The purpose of this file is to assist you in the attendance update process.   

For Example: 

If a number is entered in order to update the attendance and it is not in the file, you will get a NIF 
response.  At this point you will not know if they are a new name that has not been added to the file yet, 
or if it is a member’s card in which case you would not want in the interest file.  If you enter the the 
member numbers into this special member file, Track’em will search for that number first before the NIF 
appears.  If the number is found in the Member file, you will see a message saying “Church Member” 
notifying you that person is a member.  If they are not in that file, then you will get the NIF signal.  This 
means that you will want to enter that name into the interest file. 

How to Add SDA Members to the Member File 
1. To add names to this file, go to the SDA Members option from the Edit Menu. 
2. Press the Add Button to enter Add mode.  Simply enter the name and number of the individual.  After 

entering the last name, you will be asked if you want to enter another name.  If not you will return to 
the edit mode. 

3. Continue entering the names until you are finished. 
4. Click the Close button to go to the main screen. 

How to Edit SDA Names 
1. If you are adding names and you want to edit a record that has already been saved, you must first exit 

from add mode.  Use either the {Save and Exit} or {Cancel and Exit} button. 
2. Then you can edit the records as usual. 
3. You can search for the names by using the Record Selectors at the bottom of the screen (see Editing 

the Files), or you can search by last name. 

How to Print SDA Member Names 
You can print a list of SDA names and numbers from the SDA Members Option on the Edit menu.  
Simply click on the printer button.  The names will be printed alphabetically. 

How to Handle Inactive or Weak SDAs 
You may have some inactive SDAs  or possibly weak members coming that you want to keep in the file 
as potential rebaptisms.  Be sure that you enter them into the interest file and record the church 
preference as Adventist.  Then from the preview screen you can select church preference button, click 
Adventists, and you can see a list of your SDA Interests, all ready to print out if you want it. 
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Searching for Records in the File 

The Search Box 
The search box is at the top left of the main screen and it has the label, “Enter the Name or the Number.”   
You can locate a record by any of the four following methods: 

• Registration Number.  Enter the desired registration number followed by return and that record will 
instantly appear on the screen, the cursor is in position to search for the next item. 

• Name.  If you do not have the registration number and must enter the name, use the same procedures 
for searching by name given in the Attendance Update program given above. 

Global Search 
Global Search allows you to search for any portion of any word in the record. 

1. Open the Edit Menu 
2. Select Find from the edit menu 
3. Enter the information you wish to search for in the “Find What?” box 
4. You can select to match: 

• The whole field  (Find Smith using Smith) 
• Any part of the field (Find Smithington using hing) 
• The start of a field  (Find Smith using Smi) 

5. You can search in the current field only which is the field that is selected or you can select to 
search All Fields.  For example, if the cursor is in the address field and you select the search 
box, you would search only the address fields in the file unless you select All Fields button. 

6. You can search backwards (Up) or forward (Down) 
7. You can choose to ignore the case or match upper and lower case 

The Record Selectors 
In addition to the Search Box, you can use the PgDown and PgUp keys or triangular shaped record 
selectors at the bottom left of the screen to move from one record to the next. 

For Example: > Goes to the Next Record in the file (Also PgDown) 
  < Goes to the Previous Record in the file (PgUp) 
  |< Goes to the First Record in the file (Ctrl + Home) 
  >| Goes to the Last Record in the file (Ctrl + End) 
Click the right arrow to move down the list, or the left arrow to move up towards the top of the list, or the 
triangle and bar to go to either the first or last record. 
 Right click. On    >  Goes to the next filtered field. 
 Right click. On    <  Goes to the previous filtered field. 
For example, if you have selected the religion filter, and you right click on the right arrow, you will go to 
the first name for the next denomination.  If you are using the attendance filter, you will go to the first 
name that was there the previous night, etc.  If no filter is selected you will go to the next letter in the 
alphabetic for the last name. 

After finding the desired record, you can: 
(1)  Edit or Change any portion of the record 
(2)  Delete it 
(3)  Move it to the SDA File 
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Editing the File  
 
 

• Interest Level can be changed by typing the new letter code (A, B, C, D, E, F or G). 

• Decisions can be added or removed from the record.  If you want to add a decision you can simply 
check the decision code in any blank square next to the decision.  For example, to enter the 
decision to be baptized, click the square next to baptism. 

• Removing A Decision.  If you desire to remove a decision that has been previously entered, simply 
click that square and it will remove the check mark. 

• Attendance Update To change the attendance record, click anywhere in the attendance record area 
and a window will pop up displaying buttons that are available for you to edit the attendance record.  
Simply press the meeting number you would like to add.  If you would like to remove an attendance 
record, simply press that number and you will be asked if you want to delete it. 

• The Visitation Codes can also be updated.  Simply enter the proper code L, H, M, or P for a visit in 
the Home, Meeting, or on the Phone.  L indicates that you left a message either at the door or on the 
phone.  Then enter the two-digit number to indicate the last meeting.  For example, “H12” would 
indicate a visit in the home after the 12th meeting. 

The visitation code is as follows: 
H- Home visit, P-   Phone visit, M-  Visit at the Meeting, L for leaving a message 

• The visit code must be followed by the number of the last meeting.  For example, if a person was 
visited in the home after meeting number 4, you would enter H04.  The program will allow you to 
enter up to four visits at a time.  After four, it will delete the first visit to make room for the next. 

• The Baptism Date:  Enter the date of baptism here.  You can double click on this box and Track'em 
will enter the current date and ask if they have already been baptized.  If you click yes, it change the 
Interest Level to “G.”  Otherwise it will change it to an “A.” 

• Baptized:  Click this box and Track’em will change the Interest level to G and enter the current date 
as the baptism date.  You can edit it if you like by pressing the – sign to decrease the date by one day 
or the = to increase it by a day.  If you prefer you can simply type in the date.  Use this box for 
profession of faith too. 

• Age.  Simply enter the first number of the age and it will be assigned to the proper group.  You 
should enter a 1 for anyone less than ten.  For example, if an individual were 9 and you entered 9, it 
would be assigned to the 60+ group.  If there is no age given, enter “N.” 

• Advertising Information can be edited by simply typing the appropriate letter:  N - Newspaper; M - 
Mail; T - Television; R - Radio; O - Other; and I - Personal Invitation.  If you press I, then you will 
be asked for the name of the person who invited them. 

After completing the advertising information for each new record, you will be asked if you want to 
enter another record.  Simply select yes or no.  If you select yes you will get another clean record 
form.  If you select no, you will be returned to the edit screen 
You can use the “Other’ entry for advertising to indicate those who attend as a result of the pre-
crusade program.  (for Example Desert Storm or Operation Andrew.) You can then use the Print Pre-
crusade option from the print menu to list those names. 

• Baptism Class. Simply check the Bapt. Class field on the edit screen for each person who is enrolled 
or attending  the class.  You can print these names on a one liner report to show the names and 
attendance record of those who are attending the baptism class or taking the Bible School lessons.    
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Attendance Update 
 

The attendance update program allows you to quickly enter the names of the people attending a given 
night along with the option to enter any significant decision they may have made on their cards.  The blue 
boundaries area represents the “Interest Card” will also allow you to edit any information you discover 
on the cards turned in each night.  For example, if someone did not enter a phone number or apartment 
number on their registration card, and do put it on their nightly card, you can update the information here. 

Notice that there are two different locations for decisions.  The decisions on the “Interest Card” contains 
the decisions they have already made.  The decisions under the “Decisions to be Entered” section contain 
the decisions that will be updated onto the interest cards when you enter the registration number. 

• Press “Attendance” or “A” on the Attendance menu to enter the attendance update program. 

• Meeting number is the number for the meeting being updated.  If the cards being entered are for 
meeting number 3, enter the number 3 here.  Once done, every record entered subsequently will be 
updated for the third night.  The default value displayed here is stored in the Crusade Information 
Menu if you want to change it.  It is saved as the highest meeting number entered to date unless you 
change it. 

• Enter the Name or Number search box:  This is the place to type in either the registration number of 
the last name of the individual on the card.  You can also make use of the record search arrows at the 
bottom of the screen. Remember that when you enter a number it will automatically update the 
attendance record with the meeting number you have just entered 

• Decisions.  If there will be any decisions to enter, you can select them on the Decision box which 
says, “Decisions to be Entered.”  Use this option when there are major decisions indicated on the 
cards; for example, the decision to keep the Sabbath.  This enables you to enter both the attendance 
and the decision information from the card at the same time. 

Special Tip: 

When you have made an appeal and have decisions to enter, separate the cards with decisions from those 
that did not mark a decision.  Do the decisions first, then deselect the decision and enter the remaining 
names.  

• Undo will undo the last entry in the event if you inadvertently enter a wrong number or if you 
discover the name on the screen is different from the name on the card.  In that case, you should undo 
the entry and search for the name on the card by the last name. 

The problem arises when you undo an entry, How do I know that the name had not been entered 
previously?  For example, you have entered Mary Brown.  Later, you enter the number on Joe Smith 
card and it comes up on the screen as Mary Brown.  Obviously, Joe used one of Mary’s cards. If 
Mary had not been entered previously, you should undo her attendance update, but since Mary had 
already been entered, you do not want to undo it.  A large E appears, just to the right of the search 
entry box.  This indicates a previously entered name so you will not undo it. 

• Attendance Update Buttons are available for you to update a night or nights that may be different 
from the one on the card.  Some times people will forget to turn in their card and bring it on the 
following night.  If you would like to remove an attendance record, simply press that number, and 
you will be asked if you want to delete it.  Simple click inside the attendance record. 

• Notes:  You can make any notes you like in this field.  You can record directions to the address, etc.  
In order to start another line in the note box, press Control and Enter at the same time. 
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Entering the Data Using Attendance Update 
• Enter the registration number.  Or you can enter the last name using the following method:  Enter the 

last name, or the first three letters of the last name, and press{ENTER}.  The program will 
automatically search for the matching last name and display the first one found on the screen with a 
prompt saying, “Is this the right name?”  If it is the correct one, press the “Y” key and it will update 
the person’s record, and the screen will return to the entering format.  If it is not the correct name, 
then press the “N” key and the computer will search for the next available match.  Keep pressing the 
“N” key until you find the desired record or the buzzer indicates it is not in the file. 

It is only necessary to enter the first three letters of the last name.  The computer will select all matches 
with those first three letters.  For example, entering “Smi” will return Smith, Smiley, or Smittingly.  
This feature is valuable when you cannot read or remember the entire last name but do remember 
how it begins. 

Suppose you are searching for Mary K. Smith and the computer shows you the name Mrs. Smith, asking 
if this is the right one.  Since you are not sure, you can press {F1}, the “Help” key, and Mrs. Smith’s 
address and record will appear on the screen, enabling you to compare the two names. 

• When you press “Y”, this is the correct card, the program will automatically update the attendance 
record with the meeting number entered in the previous step. 

• If the name has already been updated for that night, you will see the red letter “E” next to the search 
box. This means that card had previously been entered as attending that night.  This will happen 
when you have entered that name under the Add Names program just a few moments before and they 
also turn in a card at the end of the meeting.. It could also happen when people share cards, so check 
the names that are displayed on the screen to make sure they agree with the name on the card! 

• If you inadvertently enter the wrong number, or the name does not match the number, indicating that 
someone has used another card, check to see if the number has been previously entered by looking 
for the red E.  If there is an E, you would want to leave the record as is, since it had already been 
entered and that person did attend.  If not, then you must “delete” that entry by pressing the Undo 
button.  Then type in the name in order to locate, and update, the proper record 

•  If the number or name is not in the file, you will see a red ? displayed next to the search box.  If you 
get a ? after entering a number, try searching for the name.  If you still get the ?, this means one of 
two things.  Either the name is an interest that has not been entered into the file, in which case it 
should be entered using the Add Names option, or it is an un-entered church member.  (For this 
reason we have the church member file which consists only of the numbers and names of the 
members.  When you enter the number of a member who has been entered into the member file, it 
will display “Church Member” on the screen.)  Try to ascertain whether or not the person is a 
member, and then enter them using Add Names, or Add Church Member. 

• If there are decisions to enter, you can select them in advance on the Decision box which says 
“Decisions to be Entered”.  Use this option when there are major decisions indicated on the cards.  
For example, the decision to keep the Sabbath.  This enables you to enter both the attendance and 
decision information from the card at the same time. 

Special Tip: 
When you have made an appeal and have decisions to enter, separate the cards with decisions from 
those that did not mark a decision.  Do the decisions first.  Then, deselect the decision and enter the 
remaining names.  You must have decisions marked on the attendance card to do this. 

• Exit the Attend Option by clicking the Close button to return to the Edit Mode. 
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Entering the Visitation Report 
 
Each day, the visitation team should turn in a report of their visits so the information in the computer can 
be updated.  A sample report form and instructions for filling it out is provided on the following page.   
 
 

The Visitation Update Fields 

This feature is convenient for entering the information from the visitation teams report sheets.  
You must select the “Enter Visits” option from the Edit Menu in order to use this feature.  You can close 
it using the same menu or by simply double clicking on any unused portion of the box. 
The information most often reported is the Visitation Code and Interest Level. 
These fields are located at the top right of the screen. 
If you are entering visits from the 9th night, you can enter H09 in the Visits box.  When you press 
“Update” each record will be updated for that visit.  The same applies to the Interest Level. 
You can also select the auto-update option that will automatically update each file when you search for 
and find the record by the number or name. 
 

For Example:  Suppose the Sabbath sermon was covered on the ninth night.  The next day you visited 7 
people who heard the sermon and all of them accepted the Sabbath and you determine are “B” interests.  
Enter H09 in the top “Visits” box, enter B in the top “Interest Level.”  Now you simply enter the 
registration number for each name that was visited, then press “Update” and all of the information will be 
entered on the “Interest Card” automatically. 

 

• If you discover they are already Adventist members, then you can press the SDA button to remove 
them from the Interest File and enter them on the Members File. 

• You can update the attendance from this screen by clicking the attendance record and pressing the 
meeting number button.  To remove a night entry, press that button again and you will be asked if 
you want to delete that entry. 

 

You can copy and distribute the following page for the visitation teams to help them report properly.  
This will facilitate data entry. 
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You should keep a record of your daily visits on the Visitation Report Sheet. 

Please turn in this report each night at the meeting.   
Hand it to the Chairman of the interest committee so it can be entered into the computer. 
 
Please print clearly to facilitate computer entry. 
 
Name- Make a separate entry for each person seen in one visit.  For example, if you see both the husband 
and wife, enter each one on a separate line. 
 
Reg. No.- You must have the correct registration number for each name. 
 
Time- Record the time of day the visit or attempt was made.  This will be valuable to you for planning 
your visits and knowing who to see in the evening and who to see in the afternoons. 
 
Contact Code- Enter the proper contact code only for those people actually seen. If you attempted to see 
someone but they were not home leave it blank.   The code consists of H- for visits in the home, M- for 
visits in the meeting, and P- for visits on the phone. The number of the last meeting should follow the 
code.  For example if you visit someone in the home after the 5th night you should enter H5. Please enter 
the codes properly, that is H4 not 4H.  Do not enter as a visit the names of those you greet at the meeting, 
you should actually exchange some meaningful information before recording it as a contact. 
 
Int. Level- Use only the codes given.  
 
Decisions- Enter only those decisions that have not already been entered. Please check your computer 
report first.  Use only the codes given. 
 

*NOTE-  Only report interest levels, decisions, age, religion etc. if the information is not in the 
computer.  Check the computer report first. 

 
 
      Interest Levels Contact Codes 
A- Will be baptized H- Home 
B- Will probably be baptized but needs help P- Phone 
C- Positive, but has questions.  M- Meeting  
D- Negative.  Probably wont be baptized L- Note at door or Phone Message  
F- Future Interest, Positive, but is leaving, etc.   
G- Baptized  



 33 

Pre-View and Print Reports 
All reports can now be printed from the PreView screen with the exception of a few special printouts.  
Even though the Print Reports menu remains on the Edit Screen it is recommended you go to the preview 
screen do print out your reports instead of using the Print Reports Menu.  It is much more flexible. 

Track'em provides the option to preview the reports in various formats before printing them on the 
printer.  This is a powerful feature that allows you to look over the names and select from the screen any 
names that you might like to edit.  The ‘Attendance Update’ or ‘Edit’ Option is selected from the top of 
the screen. 

Interest and Member Numbers 
This is a special report that will printout the names and registration numbers of all attendees, both 
members and interests.  It us usually used when there is no means available for securing a registration 
number from each person.  You can print this report out each night and give it to those at registration 
tables.  The interests can go to the table, report their names and the greeter will mark them off as present.  
You may choose to give them a ticket for the drawing or free literature at the end of the meeting.  Then 
the person updating the files each night simply enters the numbers from the printout. 

Interest and Member Tickets 
This option will print out a set of tickets which can be used in a nightly drawing.  It will print out the 
names and registration number of those attending that particular night. 

The Master Lists 
The Master Lists will include all of the names in the file in one continuous list.  They can be arranged in 
two different orders: 

Alphabet:  All names listed in alphabetical order. 

Attendance:  Will list the names of the people according to the last night they attended.  For example, on 
the 15th night, the first section will contain everyone who attended the 15th meeting.  The next section 
will list those who attended the 14th night but did not attend the 15th.  The next section will list those 
who have not been back since the 13th night and so on, down to the lower limit. 

The Visitation Team Lists 
These lists will contain all of the names for each visitation team arranged alphabetically or by 
Attendance.  Each visitation team receives only their names.  You can select to eliminate those who have 
not attended recently by setting the Meeting Cut-off limit. 

When printing the Team Lists, you will be asked if you want a page break between teams.  This 
facilitates distributing the names to each team.  However, when reviewing the names with the teams, the 
evangelist can choose to put all of the teams in one continuous print out.  This helps to save paper.  

How to use the PreView Screen 
• Click the Pre-view Button to display the names. 

• The Master Attendance List shows by default.  Notice the number in parenthesis next to the words 
“Master List.”  This is the number of names in that particular list.  This list contains all of the names 
arranged by their attendance record.  That is, all who were present at the last meeting will be first, 
then those who missed the last meeting, followed by those who missed the last two meetings, etc. 

• You can switch to an alphabetical listing of the names by selecting Alphabet in the Sort Option Box. 

• If you have assigned names to teams, you can view the names by team if you click in the teams box. 
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• Another way to view individual team names is to click on the team number at the bottom of the 
display window.  

• If you select a team number to view, you can return to the main list of all names by clicking the 
“Master List” button. 

The Meeting Cut Off Limit 
In the top left hand corner, just under the menu bar is the “Meeting Cut Off” window.  Track’em will 
select names from all records in the file unless you select a lower limit cut off.     

• This option will allow you to select the cut off point for viewing and printing names.  If you are in 
the 15th meeting, you will not want to look through all the names of those who came the first few 
nights.  You can set the lower limit to 5 and no names will be included who have not been back since 
the fifth night.   

• If you want to print all names, you must set this number to 0.  

• You can increase or decrease the cut off point by using the arrows to the right of the box.  The 
number zero means all names will be displayed.   

• There is also a check box that enables you to disable the cut off featuFor example, if the number is 
five, then no names will be listed which have not been back since the 5th meeting. 

How to use the PreView/ Edit Feature 
• Insure that the Left Mouse Button Function Option  Box at the top left of the Preview window is set 

to Edit. 

• Click the mouse on a name you may want to edit 

• Make any changes, and then click the “Return to Preview” button to return to the preview screen. 

• All record navigation options are disabled but you can delete the record from the file or move it to 
the SDA Member File.  You must return to the view screen before editing another record. 

How to Save the Filter 
You can automatically save your filter selected in the preview screen when you switch back to the edit 
record screen.  For example if you are looking at the names arranged by interest level in the preview 
mode, you can check the save filter box and when you close the preview screen you will see the names in 
the edit mode arranged by interest level.  Simply click the Show All button to restore all names into the 
file. 
This is useful for doing extensive work on a selected list of names.  Occasionally towards the end of the 
crusade, you will want to update your priority interest list.  You can easily do that by saving the interest 
level filter. 

How to use the Preview/ Attendance Update Feature 
This option will allow you to update the attendance record with a single click from the nightly attendance 
preview screen.  

• Select the ‘Attendance Update Option’ at the top of the screen.   

• If you notice some names that you know were present but had not been entered, you can click on that 
name, and the attendance record will be automatically updated with the last meeting number, that is 
displayed at the top left hand corner of the screen. 

• If you want to remove an attendance mark, simply click it again, and you will see the option to 
remove it. 

If you have a small meeting, it may actually be quicker to update your attendance for all names from this 
screen. 
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Printing From the Pre-view Screen 
You can print out any list or set of labels from the preview screen by simply clicking the print button at 
the bottom of the screen.  This enables you to preview your lists before printing them out. It is good to 
get in the habit of using this screen for all printing. 

Attendance Reports 
• A list of all names arranged by attendance. 

• This report can be sorted alphabetically or by Team Code. 

• Those attending the last meeting will be listed alphabetically under that meeting number.  Next will 
follow those who attended the previous meeting, but were not back for the last one.  Followed by 
those who stopped attending on each previous night.   

• This is very useful for seeing at a glance those who are still attending, and for noting immediately 
when good interests stop attending. 

• You can select a cut off night so the printout will not show the names of those who have not attended 
since the cutoff night.  The cutoff night can be selected from the Print Menu Option or from the 
‘Preferences’ Option under the File menu. 

Priority  Interest List 
This option will only list the names that have an interest level of A, B or C, followed by those who were 
baptized.   This report will print and arrange them by order of interest level.  That is, all A names will be 
followed by all B names and then C names.  The Baptized names will be at the end of the list.  The 
following interest codes are included in this printed report: A, B, C, and G. 

Baptism List 
This option includes all baptisms, name and address information, along with the date of baptism.  In the 
baptism list, interest level report and baptism dates set report, those who are uniting by profession by 
faith are marked with an * behind their names.  Track’em automatically selects those who have been 
marked as baptized but have no decision for baptism marked.  In order to include a name on the baptisms 
list, you must enter the interest level as “G” or you can simply check the baptized box on the edit form 
and it will update the interest level to G.   

For profession of faith, you must enter them as G or you can enter a baptism date.  In addition you must 
not check the Baptism box in the decision section of their record.   

If you want to record Re-Baptisms, you must enter a Baptism date, insure the interest level is G and that 
tat you do NOT check the decision to Unite with the church. 

Viewing Baptism Date Set  
This list includes all names with a baptism date set, grouped by baptism date.  This report is helpful in 
planning your baptisms at the end of the meeting. You must enter a date for baptism in order to show up 
on this report.   

Zip Code Assignments   
Prints a list of all of the zip codes and the visitation team assigned to each one.  This report must be 
selected from the Edit Zip Codes window. 

Viewing Pre-Crusade Interests 
You can view a list of names of those attending as a result of the pre-crusade program (For Example 
Desert Rain or Operation Andrew).  First you must indicate those names by entering both “Other and 
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“Personal Invitation” for the Advertising Information on their record.  Both of these are required in order 
for that name to show up on this list. 

Viewing List by Total Attendance 
Occasionally you may want to view the names of those who have attended a certain number of meetings.  
This feature will enable you to do that.  For example, we give out Notebooks to those who have attended 
nine meetings.  If we want to get an idea of how many have attended 7 or more times, we can simply 
click the Total Attend button, enter 7 in the Total Attendance Window and select the at least option.  
Click Save to save the selection.  You will see a list of all who have been at least 7 times.  If I want to see 
those who have been exactly 9 nights, I can enter 9 in the box and select the “Equals” option.   
Suppose you want to see those who have only attended one time in order to send a mailing to them.  Then 
enter one for total attendance and select equals. 

Viewing the Decision or Church Lists 
You can preview the names who made a particular decision by simply clicking the button next to that 
decision.  The “Unite” decision will give you the option to sort the names alphabetically or by interest 
level.  Sometimes it is useful to sort them by interest level when you get to the end of the meetings to 
help find who among your good names still needs to make a decision to join the church.  
If you want to see the names from any particular denomination, click the Churches button.  The decision 
list will change to the Church List, select that church you would like to see.   

Print Missing Names 
You can print a list of those who have missed the last few nights.  Select “Missed Last Meetings” from 
the Attendance Menu.  Enter the number of nights missed you want to see and press OK.  For example, if 
you want to see a list of those who have missed the last three nights for example:  Select Missed Last 
Meetings from the Attendance Menu.  Enter the number 3 and click OK.  This list will include those who 
have not attended from the first night on.  You can limit the list to those who have attended more recently 
and then missed. 
For example: You can limit this list to show only those who missed the last 3 meetings since the 15th 
night by taking the following steps: 
1. Go to the preview screen. 
2. Set the Meeting cut-off number to 15 
3. Select the "Missed Last Meeting" option from the "Attendance Lists" menu. 
4. Enter the number "2" in the "Select a Meeting to View" box. 
Dont forget to either disable or change the  Meeting cut-off number after printing the list. 

Print Names from a Selected Meeting 
If you would like to print a list of names who attended a selected night, select that option from the 
attendance menu, enter the meeting number you would like to see, and click OK. 

Duplicate Address List 
Track’em allows you to print a list of all names with the same address.  There are three different options 
on the menu for you to choose from: 

• Everyone at the same address.  This will include those with the same last name as well.  Use this 
list to insure that when assigning team codes, you are not splitting up one household between two 
visitation teams. 

• Only those at the same address with different last names. This will help you spot unmarried 
couples that could be living together.  Keep in mind however, that it is possible that you can have 
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children with different last names living with a mother who has remarried.  Or you could have a 
married couple with the wife retaining her maiden name. 

• Those with the same address but different Team Codes.  This will help insure that you do not 
assign two teams to the same address.  For example, it is possible that one team might request that 
you assign a name to them that they had been studying with.  Unknown to them, there may be 
someone at the same address with a different name.  If that zip code is assigned to a different team, 
that individual will be assigned automatically to another team and you will have two teams visiting 
the same house.  This will help prevent that. 

Use this list to periodically check your team assignments for the above problems.  For example a wife to 
attend the meetings alone, then her husband or child comes later.  It is possible for her husband to be 
assigned to a different visitation team.  Then you would have two people visiting at the same address. 

List  Names with  Map Codes 
If you enter the Map Codes, you can print out names sorted by Map code.  This enables you to plan your 
visits easier. 

Baptism Interviews 
There are three options from this menu “Visitation Tools”. 

(1) Baptism Interview Set: All names who have made a baptism interview appointment.   
In order for names to appear on this list, you must put a checkmark in the Baptism Interview box 
on their record. 

(2) Baptism Interviews Remaining Those who have an interview scheduled but you have not seen 
them yet.  These names have the Baptism Interview Box checked but they do not have a date set 
for baptism.  When you enter a baptism date, they will be removed from this list.  If you have an 
interview and they do not set a date, they will remain on this list as a reminder to continue 
working with them.  If you want to remove them, you must uncheck the Baptism Interview Box. 

(3) Need a Baptism Interview: Those who are A, B, or C interests who do not have an interview 
appointment set or marked on their record. 

How to use the Baptism Interview Feature 
At this point in the meetings, I suggest you reserve the interest level “A” list for those who have set a 
date for baptism.  This will be an easy way to see how many baptism dates have been set. 

(1) Make all names that should make an interview appointment as at least a C interest level.  If you 
do not think there is a chance to baptize him or her and you do not want to try to set an 
appointment, then make them either a D for no interest or F for future interest. 

(2) When you set an appointment for an interview, mark it on their record by checking the baptism 
interview box.  The name will be added to the above list (1) Baptism Interview Set. 

(3) After their appointment, if you set a date for baptism or profession of faith change the interest 
level to A and enter their baptism or POF date.  This will remove the name from list (2) Baptism 
Interview Remaining. 

(4) If after the interview they do not make a decision or set a date, mark them as B or C they will 
remain on list (2) Baptism Interview Remaining and (3) Need Baptism Interview.  If you change 
the interest level to a D or no interest level, they will be removed from list (2) and (3).  

(5) If they are interest level C or B and do not have a check in the Interview Set box on their record, 
they will appear on list (3) Need Baptism Interview 

 
This is a little complicated, but play with it and you will find it extremely invaluable for tracking the 
status of good interests and making sure they have an appointment scheduled. 
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How Enter Baptism Interview Appointments 
Just click on Baptism Interview box and you will see the form.  It gives you the option to click the day 
and time for the appointment. Simply click the day or time again to remove it.  
You can also remove an appointment by clicking the checked appointment box on the edit screen. 
To print the appointment schedule.   

1. Select  the “Baptism Interview Set” option from the “Visitation Tools” menu.  
2. Print the report. The names are listed by Day and time.  It also shows their team number, 

decisions and phone number. 
You can also determine the Scheduled appointment for each person by looking for an “A” in the visits 
field.  The “A” means it is an appointment.  The first number indicates the day of the appointment and 
the second number or letter indicates the time.  The numbers for the day begin with the Sunday of the last 
week as number one.  Two would be Monday, etc.  The numbers for the time begin with a, b, c and d for 
the morning hours from 8 to 11 oclock.  The numbers 1-9 would be for One o’clock until nine o’clock 
PM. 
Again this may seem a little complicated, but it allows us to keep all information for each name on one 
line in the printout.  To see the list of appointments and times, just print the list out form the preview 
menu. 

View Statistics Report 
Click the Statistics button. 
This report displays the attendance for each night.  It also compares each night to the percent of opening 
night.  You can use this feature to compare one crusade to others.  You can also see how many names 
you lost each night and how many new names came each night. 
Stats show the number and % of baptisms for each age, church and advertising method.  The first 
percentage figure is the percent of that group that were baptized.  The second one is the percent of the 
total baptisms that came from that group.   
 EXAMPLE:  Mail  100  10  (10% - 20%)  means there were 10 baptisms from the handbill.  10% of 
those coming from the handbill were baptized, and 20% of the total baptisms came from handbills. 
 
In order to print out a copy of the statistics report, you must first view it on the view screen and then click 
the print button. 

Visitation Statistics Report 
Click the Statistics button. 
Click the Visitation Stats button at the bottom of the statistics screen.   
This  Option displays: 

• Total names assigned to each team. 
• Names visited by each team. 
• Interest Level A, B C and Baptisms for each team 
• Number of Active Names and Active Visits.  (Active names have attended at least 4 times) 
• Current Names Visited.  (Current names are those who have attended once out of last 3 meetings.) 
• Sabbath  Names and Visits.  Those who heard the Sabbath sermon.  Track'em will count the names 

for each team who heard the Sabbath, and it will also count the number of those who have been 
visited after the Sabbath Sermon.  In order for this count to be accurate, you must insure that the first 
Sabbath Sermon title in File- Preferences has the word Sabbath in it.  Track'em will notice which 
meeting that is and will count the visits made after that meeting. 
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• Gospel Names and Visits.  Track'em will count the people who have been visited and have “Accepts 
Christ” marked for a decisions. 

• Last Visitation Report Turned in. 
These reports will be helpful in managing the visitation teams. 
Click Print to print the report. 
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Print Mail Labels 
 “Track’em” gives you many options for printing out a set of mailing labels for Avery 5160 labels.  You 
can select to print labels for all names, active attending names, priority interest levels, and those who 
have been baptized etc.   
To print mail labels 

1. First select the filter or list of names you would like to 
mail to.  For example if you want to mail to those who 
were baptized, click on the baptized button. 

2. Set the desired Attendance cut off point 
3. Click the “Mail Labels” button in Mail List Options box 

on the right side of the window (see Figure 1 on right). 

You can choose to select only those on the mail list by checking 
the “Mail List Only” box.  If this box is checked, only those names that have “Mail 
List” (Figure 1) checked on their records will be printed.     

Working with Mail Lists 
When you are ready to do a mailing, you don’t want to print a label to 5 people in one house.  Select only 
one person per household as the head of the house based on name and age, then check mail list for that 
name.  Uncheck mail list on all others. That should be done when originally entering the names but some 
times it is overlooked or others from the same house came on a different night. Track’em has some 
powerful tools to help you clean up your mail list and make sure none slip through the cracks.   

Viewing Mail List Data 
The easiest way to work with a mail list is to click the “Label” check box in the “Mail List Options” box 
located to the right if the data window (See Error! Reference source not found.).  This will change the 
information displayed in the data window to that which is more helpful when cleaning up a Mail List.  
Most noticeably, the Names which are entered on the mail list are indicated by the (ML) in the first 
position of each line the age group is at the end of each line.  Attendance, which is not as important for 
Mail List work is condensed to show only the total number of nights attended (T = xx) and the last 
meeting attended (LM = xx).    
For Example: 

(ML) Colon, Jac (Aub98001)  30240 38th Pl South T=4  LM=08/   60-69 
 

Any additional information can be seen by selecting 
the “Edit Option” in the “Click for Edit/ Mail List” 
box (Figure 2) and click on the name to see the edit 
screen.   
The “Mail List Only” option will remove all names from the  
display that are not on the mail list.   
To change the Mail List make sure the “Mail” option is selected in the  
“Click for Edit/ Mail List” box (see) and simply click on any name that you want to add to or take off of 
the mail list.  Look at the (ML) indicator to insure you clicked on the correct name.  To make additional 
changes to the record, click “Edit” Option and then click the name. 

Figure 1 

Figure 2 
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Clean up Mail Lists  
This option is available from the preview screen in the in Mail List Options box  (see Error! Reference 
source not found. above) and under the Mail List menu called "Clean Up Mail List." You can also use 
the Ctrl-C key. 
It searches for all names at the same address, and then displays only the records of those who have either 
more than one person at an address on the mail list or no one at an address checked to be on the mail list. 
You can tell who has the mail label checked by the (ML) in the first position of each line. 
 

Notice the Click for Edit/ Mail List Option 
box at the top right of the data window.  The 
default option is Mail.  If you click on any of 
the names you will see the Edit Mail List 
window appear (see Figure 3) displaying all of 
the names at that address along with their age 
groups.   
If you see more than one name on the mail list 
from one address, decide which one is the 
head of the house and un-check all other name 
that have a check in the mail list box.   
You can quickly scroll through the file using 
the navigation buttons at the bottom of the 
window. 

 
Examples for Mail Label Lists 
a. To select labels for only the baptized list or the priority interest list or any specialized list, select that 

list first then select Labels from the Mail Label or List Option on the right side of he window. 
b. To select Active attending names, set the Attendance cut off, at the top left of the preview screen.  

This will eliminate those who have not attended since the selected meeting.   
c. If you want to send a mailing to those who have missed the last three nights for example:  Select 

Missed Last Meetings from the Attendance Menu.  Enter the number 3 and click OK.  Those names 
will be displayed.  Click the Mail label box and print. 

d. If you have a large mailing and want to do bulk mail, you will want to sort the names arranged by 
zip codes.  Select Sort by Zip codes from the Mail List menu for that option. 

Interest Card Labels 
This option is provided for those who like to use cards for visitation.  You can print labels with the 
Name, Address, Phone, Religion, Age, and Advertising Information along with any notes that have been 
entered.  You can attach the labels to a 4 x 6” card.  This option uses the Avery 5163 2” x 4” label. 

Note: this is not a mail label.  It is strictly for use on Interest Cards. 

You will be asked if you want to print labels for all names or only the Active Names (those attending at 
least 4 times). 

You will also be asked if you want to skip those names that have not been assigned to a visitation team. 

Track'em will only print these labels one time for each record.  When the label is printed, Track'em will 
flag that record and skip over it next time you print labels.  You can reset the flag in order to print labels 
more than once if you desire.  Reset the flag from the Tools menu.�

Figure 3 
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Reading the Reports 
 

• Each day you should print an updated Attendance Report for your interests.  This will be you main 
working piece, as all of the most recent information will be found here.  You can know at a glance 
who was present at the last meeting and who of your best names may have missed. 

• You should purchase a loose-leaf book with numbered index tabs from 1 to 30.  Keep these reports in 
your loose-leaf book filed under the number tab of the appropriate meeting number.  When visiting it 
is best not to write notes on this sheet because you will have notes scattered over 25 different pages.  
You should keep all notes on the master card. 

 
The following information will be found on the one-line reports: 
         02  3456  Jones, Mary     235 Main Street     Sea98024 (941-1234)   123-4567123-567-012-4567-------B/ C-S-B-U   H04P08H13 

Team Code Number: 
02-  A two-digit number to be used in reporting all visits. 

Registration Number: 
3546-  A four-digit number to be used in reporting all visits. 

Name, Address, City, Zip Code and Phone Number: 
Notice that only the first three letters of the city are given followed by the zip code; the phone number is 
enclosed in parentheses. 

Attendance: 
The attendance is recorded for each night.  A single digit will be located in the appropriate position to 
indicate attendance.  A (-) will indicate that they missed that night.  For example: 
 123-567--012-4567-------B/  C-S-B-U 

This would indicate that the individual was present for the first three nights, missed number 4, attended 
the next three, missed 8 and 9, attended nights 14, 15, 16, and 17.  Notice that once the 10th night is 
reached, only the second digit is printed so that the 0 actually means the 10th night. 

Interest Level: 
The letter immediately following the attendance record is the interest level.  If no interest level has been 
reported, the space before the slash will be left blank.  In the above example the interest level is B. 

Decisions: 
Following the interest level all decisions made will be reported.  The decision codes will be found at the 
bottom of the Visitation Report Sheet (see last page of this chapter).  In the example above,  
C-S-B-U means that the individual Accepts Christ, Accepts the Sabbath, Desires Baptism and Desires to 
Unite with the SDA Church. 

Visitation Code: 
H04P08H13   This code indicates that Mary Jones was visited in her home after the 4th meeting, by phone 
after the 8th meeting, and again in her home after the 13th meeting. 
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Count Team Names 
This provides a quick accurate count of the actual number of names that have been assigned to each 
Visitation Team. 

Mark All Displayed Records 
Each record has a checkbox down at the bottom right corner Called “Mark to Print.”  You can manually 
select records to print, by checking that box on the ones you choose.  For example if you want to print a 
list of names to see you can simply check each one, then you can view the list on the PreView screen by 
selecting “Marked Names” from the Tools Menu. 
The Mark all Displayed Records Option allows you to filter a group of names and Mark them all at once. 
Use the “Clear Markers” option to remove the check marks from all marked records. 

Clear Interest Card Flags 
You can clear all of the interest card flags to reprint interest cards by selecting this option. 

Export to a Bulk E-Mail Program 
You can use this feature export supplied E-Mail addresses to a bulk E-Mail Program for sending E-Mails 
to Interests in your files. 

1. Select “Export to E-Mail File” from the Tools menu. 
2. Select a name for the file and the Folder you want to store it in. 
3. Trackem will export a text file, delimited by commas, with the following headers as the first line: 

Name (First Name and Last Name), FName, LName and E-Mail Address. 

• You can select the names to E-Mail to by selecting a filter first, then exporting the E-Mail file. 

World Cast is a good Bulk E-Mail Program which has a shareware version that can be obtained at 
http://www.fairlogic.com.  World Cast is very easy to use. We do not provide Tech Support for using any 
bulk E-Mail program.  You must get help from the supplier if needed.   
Also be careful to avoid sending E-Mail to anyone who might consider it spam. 

Export to DeLornes Street Atlas Maping Program 
 

Mail Merge 
You can create a mail merge file to be used by MS Word for Windows.  
Select a filter to select the names you want in the Mail Merge file. 
Select “Write a Mail Merge File” from the Main Page Tools menu. 
You will be asked if you want to eliminate names that are not found on the mail list. 
You will be asked for a file name and destination. 
If you are using the Track'em templates you must leave the file name, TracMerge.doc in the Track'em 
folder. 
The merge file will be found in the Track’em folder with the name, TracMerge.doc 
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Export to Pre-Meeting File-  
Use this feature to export your data from a pre-meeting interest file to a separate file that Trackem uses to 
automatically fill in the names of prior interests who attend the meeting. 

Using the MS Word Macro to make a list of registration numbers 
Track'em comes with two Microsoft Word templates named, Trackem_MergeList.dot and 
Track'em_MergeList 1 Column.dot.  They can be found in the C:\Program Files\Trackem folder.  I 
suggest you creat a short cut to them by right clicking on it and draging them to the Track'em group 
folder. 
When you double click on that file or short cut it will automatically execute a macro that will merge the 
Track'em data into a list of names and registration numbers only. 
 
You can use this macro as a pattern to make others that are customized to your own wishes.   
Steps for using the Registration List Macro 
1. Select a filter from Track'em, or you can use all names. 
2. Select the Write a Mail Merge File option from the Tools menu 
3. Double click the Track'em_MergeList.dot template or shortcut.  
 
MS Word Mail Merge files give you the opportunity to make any kind of report you like with the 
information that you choose from Track'em.  It is worth the time to learn how do do mail merges and 
macros.  I will be sending out more templates as we develop them. 

Steps for Modifying a Microsoft Word Template 
The Trackem_MergeList.dot template is a four column document that will print out only the name and 
registration numbers. 
 
Track'em_MergeList 1 Column.dot. is a normal one column document that contains Registration 
numbers, names, addresses, phone and attendance.  You can easily modify this template to add or delete 
any fields.  Use the following steps: 
1. Open the template by using the open file option from Word.  Change the files of  type option (at the 
bottom of the open files dialog box) to Document Templates (.dot). 
2. Then select the document and click on open. 
3. Use Save As to save the document under a different name. 
4. You will be looking at the template for the mail merge form.  Remember that a template is the pattern 
for which a new document will be based. 
5. To delete a field, select the entire field complete with the markers on each end and press delete. 
6. To add a field, put the cursor where you want the field to appear, using spaces or tabs, etc.  Then click 
the Insert Merge field button just above the document on the Mail Merge toolbar and select the field you 
desire to add. 
7. To test the merge, click the merge button, and you will see one page for each name displayed.  Make 
sure it is just the way you want it.  Save the Template and to use it simply double click on it.  Word will 
open a new document with the names merged. 
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In a large crusade where several teams are doing the visitation, you must divide the names.  The easiest 
way to accomplish this is to divide them by zip code.  After a few nights (3 or 4), when you have a good 
sample of names, use this feature to make the assignments.  After the zip codes have been assigned to the 
Visitation teams, the computer will update the records in the file automatically.  Then each name will 
automatically be updated with the proper Team Code when initially entered into the computer. 

If a team code has been manually assigned to the name, the auto-update will not override that assignment.  
Therefore, it is best to change the team codes for names the visitation teams want before, automatically 
updating the file. 

Example:  If you have been working with a family who is not in your zip code area, they would 
automatically be assigned to someone else.  Therefore, put your team code number on the record first, 
and the manual assignment will override the automatic zip code assignment.  

When you press the “Update File” button the computer will look at each record in the file.  If the team 
code is not “00”, it will skip to the next record.  If it is “00”, the computer will check the zip code, look 
for the team code assigned to that zip code and write it to the record. 

How to Assign Zip Codes 
1. Select “Team Assignments” from the Edit Menu.  Two forms will appear: 

a.  Zip Codes Form.  Enter the team codes for each zip code. 
b.  Visitation Team Count Estimate Form.  Track the number of names assigned to each team.  

This is an estimate, not actual account.  It does not take into account any manual assignments you 
may have made.  For example, if you assigned 10 names from Team #1 zipcode, to Team #2, it 
will count those ten as being in team 1’s list.  To get an accurate count, you should use the Count 
Team Names from the Tools Menu. 

2. Assign the team code number to each zip code by typing the Team Code number next to that zip code 
on the “Zip Codes Form.” 

3. You see a running count of the names assigned to each team as you go along on the “Team Count 
Estimate” form.  You can make any changes you like until you have them balanced the way you want 
them.  So far no changes have been made to the records in the file. 

4. Click the “Update File” button to make the changes to the file.  The program will search each record 
in the file, look at the zip code and automatically assign the proper team code. 

5. You can run the “Update File” option as often as you like.  It will only change the team codes that 
have been entered in as “00.”  It will skip any other team assignments.  For example, if team 01 has a 
name that should be visited by team 02, you can change that name to 02 using the Search and Edit 
option.  The subsequent running of the assign team code program will not affect that record, even 
though it may be in a different zip code because the team code assignment overrides the zip code. 

Caution:  Once you run “Update File” you can’t automatically undo the Assignments made.  Be 
sure you are satisfied with the assignments first.  They can however, be changed manually. 

“Track‘em” will store the zip code/team code assignments and automatically update the team code 
on the new names entered using the Add Names option.  This automatic feature will only work if 
you assign “00” for the team code when the name is being entered.  It will not override a manually 
selected team code.  Therefore, if you enter a new name, which you know belongs to one of the 
visitation teams, you should assign that team code number when you enter it.  Otherwise, if you 
enter it as 00, it will be assigned to the team with that corresponding zip code. 
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If a new zip code is entered, after assignments have been made, then it will not be in the zip code 
file.  The program will not be able to automatically assign that name to a team code.  You should 
check the zip code list in this program and update the assignments periodically, especially when 
entering a lot of new names.  It is usually best to wait two or three nights before making the team 
code/zip code assignments. 

How to Check for Multiple Team Assignments to the Same Address 
The “Check for Duplicates” option on the preview screen will automatically look for any names with the 
same addres and compare the team code assignments.  If you have multiple team codes assigned to 
different members of the same household, it will list those names for you. 

1. Select the preview screen button from the edit screen. 
2. Select “Check for Duplicate Address with Different Team Codes” option. 
3. Make any necessary changes by clicking on the records that need to be changed. 

 
Note:  when entering the names you should use a standard form for Ave, St, Appartment Number, etc. 
I suggest you do not use any punctuation, make sure the spaces between street and number are standard 
etc.  Any variations will not be detected as duplicate by Trackem.  In addition, only the first 15 characters 
are compared.   

How to Change the Team Names 
If you like, you can change the phrase “Team #” to the team’s name. 

1. Select Preferences from the File Menu. 

2. Click the “Team Names” tab. 

3. You cannot change the Code Numbers.  You can change the Name and enter a telephone number. 
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This menu is another powerful feature that will allow you to view a selected set of records in a selected 
order.  
 In addition to  viewing the name in the edit mode, you can also do a mail merge and print labels to those 
names selected by the filter.  Simply select a filter first, then do the mail merge or mail labels funciton. 
When you select a filter other than "All Names Alphabetical," you will see the following: 

(a)   You will be asked to set the meeting cutoff number. 
(b)   The selected filter will be indicated in the filter window  on the right end of the button bar and 

the filtered field will be highlighted. 
(c)   The "Show All Names" button will appear on the button bar.  After you have finished working 

with the filtered names, click that button to restore all names and restore the screen to its normal 
mode. 

The following filters are available: 
(1) All Names Alpha-  will allow you to view all of the names in the file arranged in alphabetical 

order.  This is the main filter that you will use.  After using any of the other filters you should 
select this one. 

(2) Alpha Cut Off-  This filter will arrange all names by alphabetically with the option to eliminate 
those who have not attended since a certain meeting. 

(3)  Team Code Filtered-  This filter will arrange the names alphabetically by Team Code. Or it 
gives you the option to select a particular team. 

(4) Attendance-  All names by Attendance 
(5) Attendance: Attending a Selected Meeting- Select the meeting number and you will see only 

the names of those who attended that meeting.  You can use this filter for a Mail Merge file or 
to print mail labels. 

(6) Attendance: Missed Last Meetings- This filter lets you select the number of meetings missed 
and will show a list of those who have missed those meetings.  For Example, if you select the 
number 3, it will select those who have not been back for the last three meetings.  

(7) Attendance: Total Meetings Attended- All names arranged by the total meetings they attended. 
(8) Age Group:  
(9) Advertising:  Names are sorted according to Advertising and attendance.  All names present at 

the last meeting will be first Followed by the next to last meeting, etc. for each Advertising 
item.  There will probably be more names present than the total names in the file because each 
person may have checked one or more advertising methods. 

(10) Baptisms-  This filter will select only the names that have been baptized.  (Interest level G) 
(11) Baptism Dates:  will select only those names that have a baptism date set. 
(12) Decisions: 
(13) Duplicate Addresses:  This is the same as described in the Preview Section. 
(14) Interest Level- This filter will select only the names that have an interest level of A, B or C and 

arrange them by order of interest level similar to the information in the preview by interest 
level option discussed above.  That is, all A names will be followed by all B names and then C 
names.  The Baptized names will be at the end of the list.  Since this filter does select names 
from the file they will not all be present.  

(15) Mail Lists:  
(16) Needs a Baptism Interview:  Those A, B and C level names that have not yet made an 

appointment for an interview. 
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(17) PreCrusade Names:  Those who were invited by church members. 
(18) Religion: all names arranged by Church preference indicated on the registration card. 
(19) ZipCode:   will give you all names sorted by zipcodes. 
(20) Marked Names:  All names that have been marked to print. 
(21) Clear the Mark to Print Checkmarks. 
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Keyboard Shortcuts 
Ctrl - A Add new records 
Ctrl - G Global Search 
Ctrl - H Help Files 
Ctrl - U Update Attendance 
Ctrl - V View Statistics 
Ctrl -Z  Undo last change 
Ctrl -X  Exit Program 
{F1}  Help Files 
{F2}  Copy data from previous record into that field 
{F3}  Copy data from previous record into the current record. 
{F7}   Go to previous record 
{F8}   Go to next record 
{Shift – Del} Delete current record 

Insert Information from Previous Record 
When adding new names to a database, you can press the F2 Function key to automatically insert the 
information from the previous record.  For example, if you have two people from the same family, after 
entering the first one, you can use F2 to copy the duplicate fields. 

Auto Capitalization 
When entering the First and Last names, city and state, the first letter will automatically be capitalized.  
You do not have to pres the shift key. 

Telephone Numbers 
You can simple enter the numbers without spaces or dashes and the program will supply the dash 
automatically.  Example: 12334567 will be changed to 123-4567 

Preview Screen 
After entering the attendance data, click the preview button to see the names arranged by attendance.  If 
you see a name you would like to edit, simply click that name and you will go to the edit screen. 
If you see some names that attended but were not updated, click the Attendance Update Option at the top 
of the Preview screen and then click the name.  It will automatically be updated to the last meeting 
number. 
 

Next Field Button 
If you right click either of the two "Next Record" buttons at the bottom of the edit screen, you will 
immediately go to the next record with a different search field.  For example, in the normal alphabetical 
sort mode, you will go to the next first letter of the last name, from A to B etc.  If in Attendance Filter, 
you will go to the next meeting number, Religion Filter will take you to the next religion; Interest Level 
Filter will go to next Interest level, etc. 
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Move a Name to the Member File 
Right click on this button to edit member names. 

Undelete Records Button 
The first time you click this button you will switch to the filter to show all names that have been deleted 
since the last time you compacted the file.  Find the record you want to restore to the file and click the 
Undelete button again.  It will be restored. 

Erase Changes to Record 
The delete button will remove the record from the file.  This button will simply erase the changes you 
have made to a record before saving it.  If you type over some information and want to go back to the 
original, you can use this button. 

Handling Baptisms 
If someone decides to be baptized tomorrow night, for example:  

1. Double click in the Baptism date box. 
2. You will see the message, Have they been baptized?   Press "NO." 
3. Today's date will appear.  Press the +/ = key one time and it will increase the date one day to 

tomorrow's date.  (the minus key will reduce it one day per click)  This will allow you print out a 
list of names of people being baptized for the upcoming nights. 

4. When a person is baptized, you can check the Baptized box and two things will happen.  First the 
current date will appear in the date baptized box, Second the interest level will be changed to "G"  
(G (for good) indicates those who are already baptized.) 

5. Try to get the birth date so you can enter it in the appropriate box.  When you print a list of 
people baptized, it will show the birth date.  This is helpful for the clerk in completing the 
baptismal certificate. 

Mark a Record to Return to Later 
Click the Mark a Record button and the last name will appear in the marked record window.  Move to 
some other record and then Click the Go to Marked record and you will immediately return to the marked 
record. 
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Statistical Analysis 
 
 
This part of the program compiles for you helpful information about the meetings.  The basic statistical 
screen appears, giving you a wealth of information with which to evaluate your crusade.  You can see 
which religion and age groups your advertising has pulled.  After you have entered the entire crusade’s 
data, you can evaluate which age groups and methods of advertising yielded the best baptisms. 

On the left hand side is information concerning the nightly attendance.  The first column lists the meeting 
number, the next column tells you the number of cards entered for that night.  The third column tells you 
the percentage attendance, with Opening Night being 100%. In this way you can compare the attendance 
percentages with other crusades.  The fourth column tells you how many new names were entered for 
that night, with the number on the right of the slash mark being the average number of new names for 
that night.  The same is true for the last column, only this refers to those who haven’t returned since that 
night.  These are your losses. 

Select Statistics from the Preview Menu to see the statistical data.   
Click the Print button to print the report. 

 

Stats show the number and % of baptisms for each age, church and advertising method.  The first 
percentage figure is the percent of that group that were baptized.  The second one is the percent of the 
total baptisms that came from that group.   
 EXAMPLE:  Mail  100  10  (10% - 20%)  means there were 10 baptisms from the handbill.  10% of 
those coming from the handbill were baptized, and 20% of the total baptisms came from handbills. 
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Track’em comes with a Microsoft Excel worksheet with macros that will import data from Track'em into 
various tables and graphs in Excel.  Simply click the Excel option from the Tools menu.  You must have 
MS Excel for this option to work. 
Some of the graphs will track SDA members attending and total head count each night.   
Since this data is not tracked within Track'em, you will need to manually enter it into the spreadsheet 
using the following steps: 
1. Select the Attendance Tab 
2. Enter the Total Head Count into column N under the appropriate meeting number,  
(displayed in column B).  The proper cell should be selected automatically. 
3. Count the Total SDA Cards turned in and enter in the appropriate meeting number for column H. 
4. Set the opening night in the date column C5.  You can set the dates in column C to correspond to your 
meeting days.  The default is set for opening on Friday night and taking off on Wednesday and Thursday.  
Look at the formula in the date column.  They are based on the previous cell, +1 or for the two days off, 
+3.  Adjust yours accordingly.  Then you will not have to change it for every meeting.  The only one you 
need to change is the first opening night date. 
5. You will also need to input the Master Attendance Averages into column P.  You can get this 
information by merging your crusade files together after you have finished a meeting into a New Crusade 
called Master Crusade.  Be sure you have entered all of your baptism information first before merging the 
last crusade into the master. 
6. Your added information will automatically added to the graphs. 
This means if you make any changes to it you will change the master default.  If you want to save a copy 
of the Spreadsheet before making changes, you should save it under a different name.   
After you have finished the meetings you can change the name to correspond with that crusade and save 
it somewhere else.  Just remember that for the feature to work from within Track'em, you first view the 
stats within Track’em or start the spreadsheet from within Track'em.  These two things will save the 
latest data from Track'em and the spread sheet will automatically read it when you open it.   
NOTES: 
You must have a copy of TrackemStatsPackage.xls in your Track'em program folder.   
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Track‘em Tutorial 
 
 

Getting Started 
All instructions given in the {} brackets indicate the menu item or button on the screen, or the actual key 
that should be entered in at the keyboard.  Any letters or words that you should type will be enclosed in 
quotation marks and italicized.  If you are unfamiliar with using the mouse, read and work through the 
introductory section of your Windows manual.  To become familiar with “Track‘em,” follow all of the 
instructions given here and enter the information into the computer as a learning experience.   

Throughout the program, if a button or menu item has an underlined letter, there are two ways to activate 
that option.  You can single click the item with the mouse, or press the underlined letter in the button.  
For example, I could activate “Add Names” on the Records menu by Clicking it with the mouse, or by 
pressing {Alt} notice how the File menu is highlighted, now you can use the keyboard, press {r} to open 
the Records menu since the “r” was underlined, then press {a} to add a record.  If you see a shortcut 
indicated to the right of the name on the menu, you can also use the short cut.  For example Add Names 
has a Ctrl-A to the right.  You can activate the Add Names Screen by pressing Ctrl-A. 

Create a New File 
1. Click the Select /New Crusade option from the Initial Screen.  If this is the first time you are running 

the program, the Last Crusade Button will be disabled since you have not created any files yet. 

2. Enter a file name for the crusade, type “Trial.”  This is the file name, which will be stored on the 
disk and used as a title on the print out reports. Later you Edit the name or change it if you wish. 

3. Press {ENTER} or Click Open. 

4. You will see a reminder to enter records into the empty file you have just created.  Click {OK} 

5. Notice the red Meeting number in the top right hand corner.  This means that all names entered will 
show they attended the first meeting.  You will change this number as the crusade progresses.  Leave 
it set for the first meeting now. 

Add Names to the File 
• The cursor is now in position to enter the registration number. Type “1001”, and {ENTER}. 

• You are in the first name field; enter the first name “Pastor Jac”.  Press {ENTER}.  

• Enter the last name, “colon” using lower case.  Press {ENTER}.  Notice that the c has been changed 
to upper case automatically. 

• After thinking about it, it would probably be best to leave off the title on the first name since he 
didn’t put it on his card.  Move the pointer with the mouse, and click in the First Name box.  You can 
delete the word Pastor by highlighting it (Double Click) and pressing {DELETE}, or by placing the 
cursor in front of the word and pressing {DELETE} seven times.   

• Now move the mouse pointer back to the ADDRESS box and click it. 

• Now type in the address. “30240 38th Pl. S.”  Press {TAB}.  You can use either the Enter or Tab key 
to move to the next field. 

•  ZIPCODE:  Enter “98001” AND {ENTER}.  

• CITY:  “Auburn” Be sure that you type the correct city name with the zip.  The first time you enter a 
zip code, the city name will be saved with it in a special zip code file.  From now on, you will not 
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have to enter the city and state names, only the zip.  The City and state will automatically be entered 
from the zip code information.  This is the reason you enter the zip code first.  It is important to enter 
the city with the correct spelling, the first time it is entered because that is the spelling that will be 
saved.  However, if you do misspell the city name the first time, you can edit it in the “Edit Zip 
Code” option from the Edit menu. 

• STATE:  Type "WA".  After the first time, the state will also be entered automatically.  All you must 
do is press {ENTER}. 

• PHONE:  You can enter the phone number using a “-” or with no space at all.  (206-941-7235; or 
2069417235) and each one will give the same result.  Type “206-941-7235” {ENTER} 

• The mail list box has an “x” in it, by default.  If someone from this household has already been 
entered, you can click on the box with your mouse to remove the “x” or you can press the {Space 
Bar}.  It is a toggle, and can be entered or removed as you wish.  Since Jac is the first one entered 
from his household, press {ENTER} to accept the default. 

• ENTER AGE:  Type “6” it will automatically be assigned the 60-69 age group.  Do not try to type 
the group “60-69.”  Simply type the first number. 

• RELIGIOUS PREFERENCE dialog box appears next, after you enter the age.  In this box you select 
the proper church, being careful to notice the difference between “None” and “None Specified”.  
None should be used only if they indicate on the card they have no church affiliation.  If it is blank, 
use “None Specified.”  You may select from the churches listed, or type in any name you wish.  For 
this person, Press “A” and {ENTER}.  Adventist will be entered in the field. 

• Now the ADVERTISING INFORMATION:  dialog box appears.  The list of various advertising 
media is printed in the box.  You may select as many as are indicated on the registration card by 
entering the appropriate letters. 

• Enter “N” and “m”  (case is not important). The computer is now waiting for you to do something.  
If you are finished, then press {ENTER} or click {OK}.   

• The Advertising survey is the last item to enter, after pressing {ENTER} to select the Advertising 
information the {Save and New} button will be highlighted.  At this point you have three choices: 

1. If you want to enter another record.  Press {Enter}.  Go ahead and press Enter Now. 

2. If you are finished and want to Exit from Add Mode, then click the {Save and Exit} button 
or 

3. If you do not want to save the record you have just finished, or perhaps you clicked the 
{Save and New} button by mistake and find you self with a blank record and no more 
cards to enter.  Simply click the {Cancel and Exit} button and answer yes to the question 
“are you sure you want to exit without saving your changes?” 

• You have completed the first record and should now be back to the empty entry form, ready for the 
next record. 

• Enter “1002” and {TAB} for the Registration number. 

• Enter the first name “Dena” then {ENTER}. 

• Now you can begin to appreciate one of the most powerful features of the Add names option.  If you 
notice that all the remaining information, last name address, etc., is identical to the previous entry, 
there is no point in retyping it all over again.  Simply press {F-3} and you have never typed so fast in 
your life, right?  It simply puts in the same information for each field as what was last entered for the 
previous record.  It will automatically fill all fields up to Age.  Then you should enter the individual 
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data.  Note: An alternative to {F-3} would be {F-2}.  This will accomplish the same thing but it will 
only enter one field at a time and advance to the next field, Do this as many times as needed. 

• Continue until the phone number has been entered. 

• Press {SPACEBAR} or click the “x” to remove it from the Mail List box, as her husband has already 
been entered and you do not want to print two labels to the same address when printing labels.  Do 
not press {ENTER} since the cursor automatically advances to the next field. 

• Enter the remaining information:  AGE:  “4”; RELIGION:  “A” for Adventist; ADVERTISING:  
Leave blank for no entry, then press {ENTER}. 

Continue entering more records with the following information.  This time try {F2}. 

Record Number 3 

REGISTRATION NUMBER- “1003” 
FIRST NAME- “Paul & Jason” 
LAST NAME- “Colon” 
ADDRESS- “30240 38th Pl. S.” 
ZIPCODE- “98001” 
CITY- “Auburn” 
STATE- “WA” 
PHONE- “941-7235” 
MAIL- No 
AGE- 20-29 
RELIGION- Adventist 
ADVERTISING- “1” for Personal Invitation 

(This is new; after entering “I” and {ENTER}, you will see 
the Box asking for the name of the person who invited them.  
Type: “Smith” {ENTER}) 

 

 

Record Number 4 

REGISTRATION NUMBER- 1004 
FIRST NAME- Paul The 
LAST NAME- Apostle 
ADDRESS- 1200 Temple 
ZIPCODE- 11111 
CITY- Jerusalem 
STATE- Israel (IS)  This is an international meeting! 
PHONE- 123-4567 
MAIL- Yes 
AGE- 50 
RELIGION- UnSpecified 
ADVERTISING- Mail, Newspaper, TV, Radio 
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Record Number 5 

REGISTRATION NUMBER- 1005 
FIRST NAME- Mary 
LAST NAME- Magdalene 
ADDRESS- 1200 Bethany 
ZIPCODE- 11111 
CITY- Jerusalem 
STATE- Israel (IS) 
PHONE- None given  (press {ENTER}) 
MAIL- Yes 
AGE- 48 
RELIGION- Church of Christ (type it in as an option) 
ADVERTISING- Personal Invitation by Paul 
 
Record Number 6 

REGISTRATION NUMBER- 1006 
FIRST NAME- Donald 
LAST NAME- Colporteur 
ADDRESS- 123 Main Street 
ZIPCODE- 10003 
CITY- Federal Way 
STATE- WA 
PHONE- None 
 

• Oh! Oh!  You discover you made a mistake.  The Address was actually 1023 Main Street.  No 
problem, simple click the mouse in the address box, insert the 0 and then click back in the Mail List 
Box to resume entering the information.  You can make any changes you like before clicking the 
Save button 

 
MAIL- Yes 
AGE- 15 
RELIGION- Baptist 
ADVERTISING- TV and Mail 
 

• If, after finishing a card but before you click the {Save and New} button, you discover that you made 
an error. You can go back and change that error and then click the {Save and New} button. If you 
discover an error that you made to an earlier card that you already saved, then you must use the Edit 
option to make any additional corrections.  You will have to Exit the ADD NAMES option by 
clicking the {Save and Exit} or {Exit Add Mode} button.  We suggest you set the card aside and wait 
until you have finished entering the names and then edit all changes at the same time.  This is more 
efficient.  Other wise you will be bouncing into and out of Add Mode. 
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• Enter 4 more names of your own creation, making a total of ten records in the file.  Use the same city 
and use zip code 77777 for each one.  Try to use as many special features as possible, such as {F-2} 
and {F-3} for copying previous information and auto city and state from zip codes. 

• After entering all the last name, Click {Save and Exit}.  You are now in Edit Mode.  

Scanning the File 
Notice the four navigation buttons at the bottom of the window.  There should be two on each side of  a 
box that says “1 of 10.”  Click the > button to see the next name.  Click the < to go back to the previous 
name.  {PgUp} and {PgDn} will do the same thing.  >| and |< will take you to the last name and the first 
name respectively.  Scan through the files for a few moments to get acquainted with the controls. 

File Information Menu 
Select File Information from the File Menu.   This window shows the name of the database file you are 
currently working in, how many names are on the mail list, and a summary of the number of baptisms 
and names in each of the interest levels. 
Click OK when finished. 

Preferences Menu 
Select Preferences from the File Menu.   This window allows you to update the information in the 
database you are currently working in; Crusade Name (This name will appear on the Printouts, (you 
cannot change the filename) Date, the last meeting entered, Reserved Numbers, the direction to count 
reserved numbers, and the option to show decisions made in the attendance record.   
Change the Crusade Name to Auburn. 
Click Save Changes when finished. 

Back Up the File 
You will always want to back up your work each night. 
4. Insert a Blank Diskette into the Floppy Drive 
5. Select BackUp Files from the Files Menu 
6. Save trial.dta to the floppy drive. 

Print Out the File 
Let’s take a look at your handiwork.   

• Click the PreView Button (3rd button from the right).  

• Select the “Alphabetical” Sort Option. 

• Click the Printer Button. 

• Click OK to print the report. 

• Click Close Preview to exit the screen. 

Search and Edit the Files 
You are now ready to edit the records that you have entered in order to correct any mistakes. 

• The names are sorted alphabetically and you should now see a complete display of the first record on 
the screen.  The cursor is in the search box at the top left corner, waiting for you to enter a name or 
number. 
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• Type “1003” then {ENTER}.  Now you should see the record for Paul and Jason Colón on the 
screen. 

• Type “Colón” in the search box and then {ENTER}.  The record for Dena Colón should appear with 
the message, “Is this Correct?”  Press “N”.   When you enter a number the record will immediately 
appear.  When you enter the name you will be given a choice as you look for the correct match. 

• The next record displayed is Jac Colón.  Press “N”.  Now Paul & Jason Colón appears.  Press “N” 
again.  This time you will see a message notifying you that there are no more Colon’s in the file. 

• Type “Col” in the search box and {ENTER}.  Notice that the search process still works; however, it 
will identify all names beginning with Col. the first record displayed is Dena Colón.  Continue until 
you see Donald Colporteur.  You must use at least the first three letters of the last name with this 
search feature.  Using the full name as in the previous example has the advantage of avoiding the 
similar names thus narrowing the search. 

• Find Paul Colon’s record again.  Then press {PgUp} and you will find the previous record, 
alphabetically.  {PgDn} will return to Paul’s record.  Clicking the right and left arrows, > and < will 
produce the same results.  If you click the >| arrow you will go to the end of the file, the |< arrow 
goes to the first record. 

• SEARCHING OTHER FIELDS:  In the event you cannot remember a name or registration number 
and you want to find a record in the file, you can use GLOBAL SEARCH under the Edit Menu to 
find any address, phone number, city, e-mail, notes, etc. 

• Press {Ctrl-G}, or press the {Global Search} button on the far left (with binoculars), or select the 
Global Search option from the Edit Menu.  A dialog box appears.  Type “Jerusalem” and Press 
{ENTER} or click the OK button.  You will see the search option box for the first record that 
matches Jerusalem. Click through the options until you are back at the edit screen. 

• Find Donald Colporteur’s record by typing his number 1006 in the search box and press {ENTER}. 

• Let’s assume that you omitted the phone number by mistake.  Click the Phone Number field with you 
mouse.  The current number will be highlighted.  Type the number “111-2222”.   

• You may make as many changes as you like on any record in the file.  Your changes are not saved 
until you change records or exit the main screen. 

• Click in the address box and change Donald’s address to 204 South Ave.  Suddenly you realize that 
this is not Donald’s address after all.  It belongs to someone else.  The problem is that you don’t 
remember what the original address was!  Not to worry, click the Undo Changes button on the tool 
bar.  You will see the message, “this will erase all changes made to this record.  Are you sure this is 
what you want?”  Click OK 

•  It will undo all changes you made to this record since you last saved it.  After you save it, by going 
to another record, and coming back to it, you cannot use the undo changes button. 

Exiting the Session 
Close Track'em by pressing {Ctrl-X} or select Exit from the File Menu. 

Warning!!!  Always exit the program through the File Menu’s Exit option or Ctrl-x, or the 
Windows Close Window button in the top right to avoid losing any data. 

You can take a break here and turn off the machine, or you may re-enter the program.  
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Start Track'em by clicking on its icon. 

When the splash screen appears, this time it has three buttons.  Click  the first one, “Last File.”  Notice 
the file name appears just below the button. Once the program loads, you should see the first record in 
your file on the screen. 

Add New Names into the File 
The first task on subsequent nights is to add the new names to the data file. 

• Press the {New} button (second from the left, showing a blank paper), or select Add New Records 
Option from the Records Menu, or press [Ctrl-A] 

• Enter the meeting number “2” and press {ENTER}. 

• Select two or three names at random and enter them into the file using the Add Names option.   

• Notice that the attendance record begins with the 2nd meeting.   

• After adding the last name, click [No] to the question, “Add another name.” You are ready to begin 
the attendance update. 

Updating the Meeting  Attendance Record 
Now that we have entered the data into the file, and have edited any mistakes, we are ready to begin the 
nightly updating process. Select {ATTENDANCE UPDATE} from the Attendance Menu or click the 
Attendance Update Button on the toolbar. 

• Enter the meeting number “2” and press {ENTER} or click OK, since this is the second night. 

• There are two ways to enter a name to be updated for attendance.  You can use the registration 
number or the last name in the same way you used the search feature in the previous step. 

• The registration number is much faster because it knows the correct record and automatically updates 
that record.  However, sometimes people will forget their cards and then you will have to enter them 
by name. 

• The cursor is blinking in the entry box.  Type “1001” and press {ENTER}.  Just below the entry box 
is an area enclosed in a blue box. This is the record of the person you have entered, and can be 
treated as an edit screen. Notice that it has changed to show Jac Colon’s record, with updated 
attendance for the second night.  Always check to make sure the name matches the one on the card.  
Sometimes someone may borrow someone else’s card.  More about that later. 

• Type “1002” and press {ENTER}.  Dena Colon’s record is now in the Interest Card. 

• Type the following numbers:  1003, 1004.  Isn’t it easy! 

• Mary Magdalene forgot her card so you don’t have her number.  Type “Magda” and press {ENTER} 
to search for her record, just as you did in the Edit Records form.  When it appears, press “Y” and 
continue.  Notice that her record is updated for the second night. 

• Press {DONE} at the bottom to end the Attendance update session. 

• Preview the report by pressing  the{PreView} button.   

• Select {Alphabet} under Sort Options.  Now the names are arranged alphabetically 
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• Notice that the Attendance records of those who have been updated have a ‘2’ in place of the second 
dash on the attendance record.  The first timers will look like -2---etc.  Those who were present both 
nights will look like 12----etc., and finally those who missed the second night will look like 1----. 

• Select {ATTENDANCE}  under Master List Sort Options.  Notice the names are now arranged by 
the order of attendance.  Those attending the second night are listed first followed by those attending 
only the first night.  

• Print all names in the Attendance Master file by clicking the Print button. 

• Press the {CLOSE PREVIEW} Button to return to the Edit Screen. 

Meeting Number Three 
• ATTENDANCE UPDATE:  Go to the attendance update option again.  Enter meeting number “3” 

and press OK. 

• Enter 1001, 1003, 1005, and 1016. 

• Oops!  There is no number 1016 in the file.  There is a beep, and a red “?” next to the search box, 
with a message telling you that 1016 is Not In File. Either you mistyped the name or someone turned 
in a card with out registering.  Look closer at the card; it should have been 1006.  Enter it. 

• Next you have a card that says Apostle with an address of 1200 Temple Street, no first name and no 
number. Type “Apostle”.  A dialog box shows the name Paul The Apostle, with his registration 
number, address and city.  Is this correct?  Looks okay; press “Y” or click on {YES}. 

• The next card has the name Mary Magdalene on it and the number 1002.  Type “1002”.  Notice that 
the name is Dena Colón, not Mary.  This means that Mary used one of Dena’s cards.  Here is the 
problem.  Was Dena there?  You have already updated her record with Mary’s card.  If Dena was 
there and you already entered a card for her, you do not want to change the attendance record for 
meeting 3.  If you have not previously updated Dena’s record, you need to remove meeting number 
three from her attendance record, (she may not have been there).  Then you want to be sure that 
Mary’s record is updated. So here is the solution to the problem: 

• Track’em will display a Large red “E” to the right of the search box (in the same location where the 
red ? appeared)  if a record has been previously updated for that night.  Since Dena’s record does not 
have a red E, she had not been entered yet, so you will want to undo the entry in the next step.  If you 
want to see the red E go ahead and enter 1002 again.  This simply means her record has already been 
updated.  This feature will save a lot of headaches when people exchange cards. 

• Press the {UNDO} button next to the search box in order to undo the last entry.  This removes the ‘3’ 
from Dena’s attendance record.  Then enter “Magdalene” to search for her record to update it.  You 
have to use the name search since you do not have the correct number.  The large “E” to the right of 
the entry box indicates that this registration number has already been entered for this night.  For some 
reason, Mary turned in two cards. 

• Now you are looking at a card that has the name Paul Colon on it with the number 1004.  Enter 
“1004”.  This is Paul the Apostle’s record.  (Sure wish these people would use their own cards) The 
red E to the right of the entry box shows that you have already entered his card previously, he was 
there.  This time you would NOT want to delete the 3 from Paul The Apostle’s attendance record for 
the third night. He was there.  Never click {UNDO} after a registration with the E beside it unless 
you know for a fact, that person was not there. Do a search for Paul Colon to update his record. 

• Press {DONE} to exit the Attendance Update form. 
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  Meeting Number Four 
• Select the Attendance Update option again and this time enter meeting number “4”.  The meetings 

are flying by, aren’t they! 

• Enter the numbers 1001, 1002, 1003. 

• Mary Magdalene forgot her registration card again so she turned in a card, which does not have her 
number on it.  Enter “magda” and press {ENTER}.  Notice that the case is not important when 
searching for a name.  Press “Y” when you find her record. 

• You just noticed that she wrote her phone number (144-0000) on the card and you overheard the 
pastor say that he has not been able to find her house.  Enter the phone number to her record by using 
the following procedures.  Click the phone number on the “Interest Card” area, enclosed by a blue 
box, and Enter “144-0000”.  Move the cursor back to the {Enter} box.  You can edit any record 
while updating the attendance by clicking in the desired box, and changing the field. 

• Click the done button to return to the edit screen. 

• Click the Preview Button or Select the Master attendance list from the ‘View Reports’ menu. 

• You can see at a glance the four names that were entered for that meeting.  But you notice that 
Donald Colporter is missing and you saw him at the meeting.  Click the {Attendance Update} option 
at the top of the screen.  Click Donald’s record on the screen and it will be instantly updated to 
attendance for meeting number 4.   

• After you entered Donald in for meeting number four, you realize you did not see him there last 
night; it was the night before that you saw him.  No problem.  Click his line again and click yes, to 
delete the entry.  This is a powerful feature that allows you to update with one click, attendance 
records of those who did not turn in a card. 

The Fifth Meeting  Attendance 
• You have a new name to enter for the fifth night.  Press the {New} button, Select the Add Names 

option from the menu or press {Ctrl-a}.  Don’t forget that this is the fifth night of the meetings so 
enter meeting number 5 when asked by the program. 

• Enter the following name: 

REGISTRATION NUMBER- Type “1005”  (That NUMBER has already been used so the 
computer won’t accept it).  Actually, the number should have 
been 1015.  Enter that one. 

FIRST NAME- William  (Simply type over the highlighted NIF) 
LAST NAME- Miller 
ADDRESS- 1844 Daniel St., Apt. 814 
ZIPCODE- 77777 
CITY- Ascension Rock 
STATE- NY 
PHONE- 102 2440 
MAIL- Yes 
AGE- 45 
RELIGION- Baptist 
ADVERTISING- Press {ENTER} for no entry. 
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• Click “NO” to “Add another record” question and exit the Add Names option. 

• Now update the following stack of attendance cards for the fifth night using the Attendance update 
option.  Be sure to check the top of the screen after entering the meeting number to verify night #5.  
Enter:  1001, 1004, 1005, and 1015.  Notice that when you enter 1015, which is the new entry you 
just made, there will be an E by the entry box.  This is because the Add Names option will update the 
attendance record for the night the name is entered in.  You did not have to re-enter it, but the person 
unnecessarily turned in two cards. 

• Enter 1002.  You notice that the card she turned in has a phone number on it, but it is different from 
the one on the screen, on her “Interest Card”.  You don’t want to lose the current one - perhaps one is 
a work number.  In the lower right corner of the Interest Card, is a gray box titled “Notes.”  Click 
inside that box with your cursor and type “481-7171 was written on her card”.  Any notes you want 
to keep can be put in this box.  It does not print out on the one line printout, but it will print out on 
the Interest Card label, or a special printout for notes only.   

• Press the {DONE} button to return to the edit screen. 

• Click the {PreView} button. 

• You notice that Donald Colporter is shown as missing again, but you know for sure this time he was 
there.  Select the {Attendance Update} option in the “Click to Edit or Update Attendance Box.”  
Then click on Donald’s name.  He will be updated for attending on the 5th night.  This is a powerful 
feature that will allow you to do some fixing of the file, or in a smaller meeting, it can be an even 
faster way to do the attendance update.  It will always update to the last night meeting number.  Also 
notice that even though his attendance record is updated showing he was present on the 5th night, his 
name is not moved up on the list.  If you click the alphabetical button and then the attendance button 
again, then he will be in the correct location. 

• Let’s get a print out! This time let’s print out on the printer. Select “Alphabetical Report” from the 
print reports menu.  A print dialog box will come up asking to confirm that you want to send the 
report to the printer.  Check that the printer is on and ready, then press {ENTER} or click on {OK}.  
Now you should have a complete record of all names in the file. 

• Let’s get a different type of report.  Select “Attendance” option from the Preview Reports menu.  
You can simply click the preview button on the toolbar. 

• Now compare this list with the Master Alpha list.  You will notice that it contains all of the names of 
those attending the fifth night.  Paul Colón is listed after Magdalene and Miller under the fourth night 
listing because he missed the 5th meeting.  This feature allows you to keep track of your good names 
that missed meetings. 

Meeting  Number Six: Handling the Sabbath 
• There are no new names to enter this evening so prepare the Attendance update program for meeting 

number six. 

• Since there will be a decision tonight (this is the Sabbath sermon), we have a new step.  Locate the 
red “Decisions to be Entered” section on the right section of your screen.  Click with the mouse on 
the word {ACCEPTS SABBATH}, or in the box beside it.  A “CHECK MARK” appears in the box.  
Notice that you can toggle the decision on or off, so no need to worry about mistakes.  Do it a few 
times, leaving it with a check mark in the Accepts Sabbath box. Notice the message just underneath 
the “Decision to be Entered” section.  It lets you know that any decision marked here will 
automatically be updated to every person entered as having been there.  For this reason, you will 
want to put all cards with a decision on them together.  Do them all at once, then toggle the decision 
off, and enter those with no decision.  This is a great time saving feature.  It saves you from having to 
go through the names a second time to enter decisions. 
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• Move your blinking cursor back to the entry box by clicking in the entry box.  Enter “1001”.  Notice 
that on Jac’s “Interest Card” the decision “Sabbath” now has a “CHECK MARK” in it as well as 
being updated for the 6th night. 

Enter these numbers and decisions:  
1002- Sabbath 
1004- Sabbath 
1005- Sabbath 

• Enter “1015”.  Uh-oh, you notice that this card really didn’t have a decision for the Sabbath.  Go into 
the “Interest Card” (blue boxed record for that person) section on the screen, and you can take the 
decision off of Brother Miller’s card by simply clicking that box. 

• You notice that Paul and Jason’s Interest Card the Sabbath marked with a note saying that he has to 
work on Sabbath.  You could check “Sabbath Problem” under the “Decisions to Entered” section.  
But since this is the only one with a Work Probem, it is easier to simply Enter “1003” and check the 
Sabbath Problem decision directly on their card. 

• The next card has no decision.  So toggle the “Accepts Sabbath” decision off, and enter “1006.” 

• After Donald’s name comes up you notice on his “Interest Card” that his attendance record (just 
under his name on the card) shows that he missed night #5.  You happen to be sure that he was there 
last night.  Click the “Attendance Update” field in the blue boxed area.  The Attendance Update box 
appears, Click on number 5, then OK and watch his record on the “Interest Card” be updated.  Most 
items on the “Interest Card” can be updated directly on the card, but the attendance record numbers 
are too small and they must be entered in order.  This is the way you change an attendance record 
from this screen.  They can also be removed by entering the meeting number that you want to 
remove, a second time. Click #5 again.  Press OK to remove it.  Click #5 one more time to restore it. 

• Press “DONE” to return to the Edit Screen. 

• Now let’s take a look at the decisions that have been made.  Click the PreView Button.  

• Click “Accepts the Sabbath” Decision.  The decisions can be seen as an “S” on the far right side of 
each record displayed.   

• Return to the Main Menu by clicking {CLOSE PREVIEW}. 

Meeting  Number Seven: Copying a Record 
• We have a new name to enter.  Mary Magdalene brought her sister, Martha Kitchen, who just moved 

in and will live with her at the same address.  She is about 25 years old.  She goes to the Baptist 
church.  She did not register but you met her.  You still want her name in the file.   Since most of the 
information is the same, you will use the information you used for Mary on the first night.  

• Press the {New} button, or select ADD NEW RECORDS from the records Menu. 

• You have no registration number so you want the computer to generate a number for her. Press 
{TAB}.  Enter the rest of the information.  Be sure you enter the address exactly the same as Mary’s. 
1200 Bethany, zip code 11111.   

• Finish filling out the record and select “NO” to add more names. 

• Go to the Previous record by clicking the navigation [<] button at the bottom of the screen to save her 
record.  Go back to Martha’s record [>].  Notice that the Team Code has been automatically assigned 
to Team 2 because of the zip code assignments. 

• From now on, you will want to be sure to look for her each meeting so you can update her record.  
Try to get her to register and then you can assign her own number to her. 
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• Paul the Apostle brought a friend also.  His name is John Mark.  He is Paul’s roommate.  Most of his 
information will be the same as Paul’s.  Let’s use a handy shortcut this time.  Select {COPY TO A 
NEW RECORD} from the Records menu.  He will automatically be assigned a reserved number.  
Enter his name, he is 40, you don’t know his church but Paul invited him so in the advertising box, 
type “mti-Paul.”  Notice that entering the “mt” a second time removes the Mail and TV entry.  
Entering the I with a “-“ and the name, automatically enters the name of the person inviting them.   

• John was not there for the Sabbath sermon so un-check that decision. 

• He will automatically get the same team code that Paul has. 

• There are no decisions to enter tonight.  Press {ATTENDANCE UPDATE} button to update the 
names for meeting number 8. 

• Enter numbers: 1001,1002, 1003, 1005, and 1007, 1009.   

Meeting  Number Eight: Handling Baptisms 
• Press the {Attend} button to enter the attendance update screen for meeting number 8. 

• Click the {BAPTISM} Decision under “Decisions to be entered” at the right of the screen. 

• Enter numbers: 1001,1003, 1005.  Notice each one is marked with a baptism decision. 

• Uncheck the Baptism Decision by clicking it again. 

• Enter 1015 and notice his attendance is updated but no baptism decision is indicated. However 
William Miller did tell you he wanted to be baptized and to join the church.  Click “baptism” and 
“Unite” inside the interest card.   

• You saw Martha Kitchen there.  Enter “Kitchen” and click yes when prompted. 

• Click {DONE} to return to edit mode. 

• PreView the file. 

• You notice that Mary Magdalene was present and was baptized tonight, but is not marked.  Click her 
name.  You are now in the Edit Screen for Mary Magdalene.  

• Check {BAPTISM} to enter her decision. 

• Click in the attendance record box.  When the dialog box appears, click number 7, then OK. 

• Double Click the {DATE BAPTIZED} box. 

• Notice that she is upgraded to interest level G and today’s date is entered into the Date baptized box. 

• Notice that the change records buttons are disabled and the search box disappears.  You cannot view 
another record in Edit Mode when you go there from the attendance screen.  You must return to the 
preview screen again. Click the right hand button on top of the screen, the  “Preview Files Button,” to 
return to preview screen. 

• When back in preview mode, Click {BAPTISM} on the right hand side of the screen, where all the 
decisions are listed. 

• Now you should see the names of those who made a decision to be baptized. 

• Now click the {BAPTISMS} button on the left.  You see the one name of someone who has been 
baptized, Mary Magdalene. 

 
Now that you have a good working knowledge of the basics of entering, editing and printing out the data, 
go to the next section on advanced methods. 
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Advanced Methods Tutorial 

How to Handle Church Members 
The Visitation team discovered that William Miller has been baptized already and is a member, so we 
won’t want him in the file.  Find his record and click the {SDA} button on the tool bar.  You will be 
notified that you are about to remove this record and place it in the SDA file.  You will be given a chance 
to change your mind.  Press “Y” and the record will disappear.  The record has been deleted.   
Note:  Deleting a record, does not actually remove it from the hard drive.  You simply cannot access it 
any longer and it cannot be printed out. However after you compact the database it will be removed from 
the file.  If you file gets very large and you delete a lot of names, you can make it smaller by compacting 
it.  You should periodically compact the database in order to remove the deleted files from the hard drive 
and thus save disk space.  Use Compact from the Files Menu. 

 

• We have just removed the record of William Miller, and placed it in the SDA member file. 

• To see the value of this, go to Attendance Update.  Enter meeting number “7”.  Now enter the 
number “1015” into the entry box.  You’ll hear a beep, and see a red message that says SDA and 
gives you the Registration Number, and first few letters of the person’s last name and first name.  
This is important, especially in larger crusades where you have many SDA’s from various churches 
and the interest committee may not know them all.  If the program simply reported that the name was 
not in the file, you would not know if they were a member or a new interest.  This way you will know 
that it is a member and you will not have to enter the name into the file.  You will get the same 
response when you enter the last name, for a name search. 

• Select SDA Members from the Edit Menu, and click the {ADD} button. 

• Someone whom you know for sure is an Adventist turns in a card.  With no registration number on it.  
We’ll assign him the next unassigned number. Double click in the Reg. Num. box to insert the next 
unassigned number.  Press {TAB}.  Into the “First Name” box type “Bob”, and press {TAB}.  Into 
the “Last Name” box type ”Folkenberg”, and press {ENTER}. 

• Press Yes to enter another record. 

• The cursor returns to the “Reg. Num.” box, ready for you to enter the next member.  Enter the 
following information:  Reg. Number:  1016.  First Name:  Jan  Last Name:  Paulsen. 

• Return to the Edit Form by pressing the Close button, and go to the Attendance form.  Type “1016” 
into the search box, and press {ENTER}.  Sure enough, the program tells us that this person is an 
SDA 

• On the following night, Bob Folkenberg turns in a registration card with a number.  Go to the {SDA 
MEMBERS} form.  There are two ways to find existing member records.  One is Use the next record 
and previous record buttons at the bottom of the form to scroll through them.  The other way to edit 
is to click the {SEARCH} button.  A dialog box appears, with the cursor ready for you to enter the 
name or number of the person you are looking for.  Enter “Folk”, for Folkenberg press {ENTER} 
and then press {YES}.  Folkenberg’s record is there, ready to edit.  Change the Reg. Number to  
“1017”.  Press close to Return to the Edit Form. 

• We enter the members into the member file beginning on the very first night.  If you are very careful 
in sorting out the area Adventists for the first few nights, it is a big help as the meetings progress. 

Delete and Restore Records 
• Press the {New} button to add a new record. 
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• Click the previous record button at the bottom of the screen.  You will be asked if you want to add a 
new record?  Click no.  The record you started to add is incomplete.  A new unused team code is 
assigned to it and the last name is saved as Unknown.  You will want to delete this record. 

• Click the delete record button on the button bar.  It is fourth from the left from the left with a large 
black X on it.  You will be asked if you are sure you want to remove this record from the file.  Click 
yes. 

• Now the record will not show up on the edit screen or on your printouts.  But it is still on the disk.  If 
you inadvertently removed a record, you can restore it. 

After speaking to William Miller you discover that he had been baptized into the Baptist Church, not the 
Adventist Church.  He wants to be baptized and join the Adventist church.  Now we should re-enter him 
back into the file. 

• Click the {Restore a record} button, next to the Delete record button. 

• The first time you click it, it will display a message box that tells you that the deleted records will be 
displayed. Click “OK”.   

• Notice the counter at the bottom of the screen shows record 1 of 2.  You have deleted two records, 
the unknown one and William Miller, when you added him to the Member file.  Find the William 
Miller record and press the {RESTORE RECORD} to the file button a second time.  This time it will 
display a message saying, “Are you sure you want to restore this record to the file?  Click Yes. 

• In order to see the main file again, you simply click the “Show All Names” button that appears on the 
far right of the button bar.  Click {SHOW ALL NAMES} button.  Now the main data file is available 
again. 

• Type 1015 in the search box and press enter.  Notice that William Miller has been restored to the file. 

Advanced Features for Editing the File 
While going through the cards you notice some changes that need to be made.  Mary Magdalene gave us 
a Post Office box number the first night, but now we have her address. 

• Insure you are in the Main Edit screen. 

• Find the record for Mary Magdalene. 

• Click the mouse in the address field. The entire field will be highlighted.  At this point in time if you 
begin to type, everything highlighted will be erased, and replaced with the letters you type.  Enter the 
address change, “244 Rose”.  Oops!  It should have been “1244”.  This time, double click in the 
address box, just before the “2”, (or press the Home key) and type “1.” 

Managing Mail Lists 
You want to send out a mailing to everyone who has attended the meetings.  Track’em has a powerful 
mail list feature.  When you entered the names you had the option to select whether or not to enter the 
names on the mail list.  This means that you can select the mail list option and only print labels to those 
who are on the mail list.  This prevents sending more than one letter to each household. 
Use the Clean up option to check your mail list.  It searches for all names at the same address, then only 
lists the household lists of those who have either more than one person on the mail list for that household 
or no one checked to be on the mail list. 
Go to the preview screen and select the “Clean Up Mail List” option from the “Mail List” menu You can 
tell who has the mail label checked by the * in front and after the first three letters of the city in place of 
the parenthesis. 
For example:  
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Colon, Jac       *Aub* 30240 38th Pl S-   has the mail label checked.  
Colon, Dena     (Aub) 30240 38th Pl S -   does not.have the mail list checked 
Colon, Paul & Jason    (Aub) 30240 38th Pl S -   does not.have the mail list checked 

If you have more than one name  checked, you can click on that name and Track’em will take you to the 
edit screen.  Change the mail list option and click the preview button again.  You will see the change. 
 
For Example: 

Go to ‘dena Colon’s record and check the mail list option. 
Go back to the preview screen and select the clean up mail list option. 
Now you will see: 

Colon, Jac       *Aub* 30240 38th Pl S-   has the mail label checked.  
Colon, Dena     *Aub* 30240 38th Pl S -  has the mail label checked 
Colon, Paul & Jason    (Aub) 30240 38th Pl S -    does not.have the mail list checked  

Click on  Dena’s record and change the mail list check box. 
Go back to the Clean up Mail List Screen and now notice that she is indicated to be off of the mail list. 

Entering Visits 
Pastor Good Visitor has just handed you his visitation report (see page sample in the Appendix) and you 
want to enter the information into the file. 

• Enter “1005” in the search box.  Mary Magdalene’s record appears. Click in the “Visits” field.  Press 
“H” and Dialogue box will appear.  Enter the visitation code, followed by the number “15” and 
{ENTER}.  (This means that the person was visited in the Home after the 15th night.)  Oops!  The 
visit should have been the fifth night instead of H15.  Press {Del} 3 times.  This will Delete H15. 
Type H5. Press {ENTER}.  Notice that the program automatically inserts the 0 to make it H05.   

• Type “B” In the “Interest Level” box. 

• You are finished with that record, so click on “Enter the Name or Number” to be ready to find the 
next name. 

• Find Jac Colón. Enter the interest level “A”.  Notice there are decisions to enter, so in the 
“Decisions” box, Click the box for “Baptism” and “Unite with Church”.   Move into the entry box 
again to be ready for the next person. 

• Enter “1002” to find Dena’s record.  You notice that all the information is the same for her, so go 
ahead and enter it. 

• Continue with the report for Donald Colporteur, noticing that his visitation code is P05, for Phone 
contact after the 5th night.  Enter it, and also change his Interest Level to D.  There are no decisions. 

• Find Paul The Apostle and update his Visits field with H5. 

• While visiting Paul, Pastor Visitor discovered that Paul had a roommate who has attended all five 
nights but did not fill in a card.  Take the following steps to enter him. 

• Pastor Visitor’s report sheet says that his address is the same as Paul The Apostle’s. Find Paul The 
Apostle’s record, 1004.  Select Copy Record from the Records menu.  The program will 
automatically copy all of the information in Paul’s record into a new record.  The First name will be 
blank, and the Registration Number will automatically be assigned the next reserved number. 

Note: A reserved number is a pre-assigned section of numbers that you know will not be found on 
any of the registration cards.  Sometimes, people will turn in a card without registering.  Or you may 
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have a husband and wife attending but they are both on the same card.  If they are going to be 
baptized, you will want them on separate records so you can get an accurate baptism count.  You can 
assign a reserved number for them.  You can select the number that you want to start with, and the 
direction you want it to go, on the “Preferences” option under the “File Menu.”  For example, if you 
select 9000 to start your reserved numbers, and go “UP” then the first time you use that option, 9001 
will be entered.  The second time it will be 9002, etc.  If you select the “Down” option, the next time 
it will be automatically change 8889, etc. 

• Enter: 

FIRST NAME- John The 

LAST NAME- Beloved 

• Next you must update the attendance record.  Click the Attendance Record field and simply press the 
buttons for the corresponding numbers, which John came, meetings 1-5. 

• You notice the only information left on the Visitation Report Sheet, which you haven’t entered, is 
that John is 50 years old. Enter his age. 

Using Filters 
Track’em has several filters available which will allow you to search through various filtered lists of 
names.  For example, you may want to work with the priority interests or to see who the Catholic 
Interests might be, or to look at the ones who have been baptized. 

• Click on Religion from the filter menu.  You will see a box asking for the meeting number you would 
like to begin with.  This will eliminate all names that have not attended since the meeting cut off 
number.  Enter 0 and press return.  This will show all names.   

• Next you will see a message that the names have been sorted by religious preference.  Notice that the 
Edit sign at the top right of the button bar has been changed to Religion.  The top frame of the 
window now says, “Sorted by Religion.” And the “Show all Names” button is visible. 

• The names are now sorted by religion. 

• You can look through the records by clicking the right record marker. “>” at the bottom of the screen.   

• Try clicking the right mouse button.  Notice that you skip to the first name under the next religion.  If 
you are looking for all the catholic names, right click till you see the first catholic name, then use the 
left button to look at each one. 

• Click the Show all Names button to make all names available again. 

• Now click on the next record button again with the right button.  You will move to the first name 
with the next letter in the alphabet.  For example, if you are looking at Frank Smiths record, you go 
to the next last name that starts with a “T.” 
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When you have a large number of interests and several teams visiting, it is helpful to divide up the 
territory among the teams.  The easiest way to do this is to assign various zip codes to each team.  You 
can enter these assignments into the computer and then the program will automatically look at the zip 
code and assign that name to the proper team.  For example, if Pastor Good Visitor has Team #01 and zip 
code 78550 is his territory, then when you enter “01” next to “78550” in the Assign Team Code Option, 
each name in that area is assigned to team code “01” after you press the {UPDATE FILE} button.   In 
addition, each time a new name is entered by using the Add Names option, it will automatically be 
assigned the corresponding team code. 

The exception to this is if you have previously assigned a team code to a name in a zip code that has been 
assigned to a different team, it will not over ride it.  In other words, Track'em will only assign a new team 
code to those names that have a “00” team code.  For this reason it is best to make any team assignments 
to names that they would like to work with before you do the automatic update process. 

Manually Assign Zip Codes 
Pastor Good (Visitation Team #1) has been studying with Mary Magdalene.  She is in a zip that will be 
assigned to team two.  Even though she is in someone else’s zip code, he wants to work with her.  Find 
her record and enter “01” for her visitation team.  This will over-ride the automatic zip code assignments. 

View the Zip Count Worksheet 
• Select “ASSIGN ZIP CODES” from the Edit Menu.  Two new windows will appear.  

• The “Zip Code” window displays the various zip codes with the location and the number of the 
names in that zip code. 

• The “Teams” window displays the estimated number of names assigned to each team.  The number is 
an estimate because some names in a zip code may be manually assigned to a different team than the 
one assigned to that zip.  The difference, however, is marginal. 

• As you assign a team code to a zip code, the Team Window will be updated automatically. 

Change Team Names 
• Click the {Edit Team Names} button. 
• Enter “Pastor Good” for Visitation Team #1 and a phone number 
• Enter “Betty” and a phone numbers for Visitation Team 2.   
• Enter “John” and a phone numbers for Visitation Team 3.   
• Press Save changes to save and close the Preferences box. 

Assigning the Zip Codes to a Team 
The zip codes may not be the same for you if you entered zips with lower numbers than 10003 for 
example that one will be first. 
1. The first zip code displayed should be 10003.  Change the Team code to “01” and press {ENTER}.  

2. The Team Assignment window now shows that Team #1 has one name assigned to it. 

3. Click the {Right Arrow} button and you should see zip code 11111.  Change the Team code to “02” 
and press {ENTER}. 

4. The Team Assignment window now shows that Team #1 now has three names assigned to it. 

5. Click the {Right Arrow} button until you reach zip code 77777.  Enter 02 for Team Code.  See the 
count for Team 02 displayed on the right. 
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NOTE:  This is an estimate as it only counts the number of names actually in those zipcode.  Since 
we assigned Mary Magdalene to Pastor Good, and she is in the Zip code assigned to team two, that 
team will have one less actual names than shown and Pastor Good will have one more. 

6. You can use the left or right arrows to move through the list. 

7. Continue making assignments until all zip codes have been assigned. 

8. Click {CLOSE} to return to the Edit Records Screen. 

9. Notice Assigning the Zip code to a team number does not change the records in the file. Browse 
through the main data file if you like and notice there has been no change to the team codes. You 
must Update the records in order to change the team code in each record. 

Updating the Records with the Assigned Team Code 
1. Return to Assign Zips, this time by right clicking your mouse on any open space on the edit screen. 

The edit menu appears and select {ASSIGN ZIPCODES}. 

2. While the zip codes are displayed, click  {UPDATE FILE} Button.  It may not seem like it but the 
computer is very busy.  Each record in the file is being updated and the appropriate team code 
assigned. 

3. Notice the number of names indicated assigned to teams 1 and 2. 

4. Click Close to return to the edit screen. 

5. Select {Count Team Names} from the tools menu.  There you will see an instant display of the actual 
count.  Notice team has one less than that displayed in the Assign ZipCodes Section. 

6. Another way to view the actual count is to press {Ctrl-W} and view the Visitation Report.  It will 
display an accurate count of all assignments along with much more valuable information. 

7. When finished, click {CLOSE} then click the {PREVIEW} button or {Ctrl-P}. 

8. Notice the names each have a team code assigned to them.  Look at Mary Magdalene’s record.  Even 
though she is in zip code 11111 she is still assigned to team 01. 

9.  Select the {TEAMS} and {ALPHABET} sort options on the left side of the viewing window.  
Notice that now the names are sorted alphabetically by team code. 

Checking for Multiple Teams assigned to One Address 
It is possible that one team might request that you assign a name to them that they had been studying 
with.  Unknown to them, there may be someone at the same address with a different name.  If that zip 
code is assigned to a different team, that individual will be assigned automatically to another team and 
you will have two teams visiting the same house. 

• Select {DUPLICATE RECORDS} with the option to see those with “Different Team Codes” from 
the Visitation Tools Menu. 

• You will see a message that says, "You have chosen to list all names with duplicate addresses and 
different Team Code Numbers."  Click {OK}. 

• Notice both Mary and Martha are listed.  They have the same address but Mary has been assigned to 
Pastor Good, Team 01, and Martha to Team 02. We don’t want two teams going to the same house so 
Click Martha’s name to edit it and change Martha to 01, since Pastor Good has been studying with 
Mary. Return to the Preview Screen. 

• Now Select Duplicate Names with the option to show all names at the same address from the 
Visitation Menu.  It looks like all of the names match up with the same team names. 
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• Next we want to check and see if we have any possible couples living together who are not married.  
Select Duplicate Names with the option to show only names at the same address with different last 
names from the Visitation Menu.  All of the names match up with the same team names.  Mary and 
Martha are sisters, no problem there Paul and John Mark are ok.  So we should be ok.   

• You should check both of these reports periodically while adding names, to see if there are any new 
problems. 

************************************ 

Adding New Names with Assignments 
1. Lets add a new name to the file.  Automatically assign an unused number by pressing the TAB key. 

Enter the name “Good Dog” and an address with zip code 78550.  When finished, click {NO} to add 
another record. 

2. Mark the record by clicking the {MARK RECORD} button on the button bar.  Notice that the name 
“Dog” appears in the record marker window on the toolbar.  This serves as a bookmarker for that 
record.  More about this later. 

3. Select the {ASSIGN ZIPCODES} option from the {EDIT} menu. 

4. Find the new zip code 78550, (hint, it should be the last zip code in the file) and assign team code 
“02” to that zip code.   

5. Press {UPDATE FILES} to update the file again.  The names that have been already assigned will 
not be changed.  The only names assigned the new team code when you press {UPDATE FILES} 
Button will be the ones with a 00 team code.  Our new record for Good Dog should have been 
updated to team code 02.  

6. Add another new name, using an unassigned registration number and type the name “Little Dog.”  
Enter the same address and type in the same zip code, 78550 and press {ENTER}.  Notice that the 
city and state are automatically entered from the zip code file and the team code is automatically 
assigned to team 02.  Finish entering the information for “Little Dog” and Select {YES} to enter 
another new record. 
Helpful Hint:  When entering a stack of new names, it helps to pre sort them into zip codes, that way 
you can press F2 for the zip code and you will not have to continually type in the city and state 
information each time. 

7. Use an unassigned registration number and type the name “Bad Cat.” This time, before you enter the 
address, click on the Team Code Box and enter team code “05” because that team has already been 
studying with Bad Cat.  Enter the address using the same zip code “78550.”   Notice this time that the 
team code is not automatically assigned to “02” since automatic assignments are only made to 
records with a 00 team code.  Finish entering the information and click {NO} you do not want to 
enter another record. 

8. In Edit Mode, click the {GO TO MARKED RECORD} button on the button bar.  (It is the one with 
the hand pointing right).  You will return to Good Dog’s record.  That is the one we marked.  Notice 
that it still has team code 02.   Remember, only the names with team code “00” are updated 
automatically. 

How to deal with Large Zip codes 
Sometimes in large meetings you may have to divide a zip code between two teams.  This must be done 
manually.  First assign the zip code to one team.  Then when you press {UPDATE FILE} all names in 
that zip code will be assigned to that team.  Then you must go through the names and manually change 
the team number for to the second team for that zip.  Use the following method. 
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(1) Click the PreView Button to see the PreView screen 

(2) Click the Zip code Filter button on the left hand side of the window. 

(3) Check the Save Filter Box 

(4) Right click the next record button {>} at the bottom of the window to go to the next zipcode.  
Keep searching till you find the zip code you want to assign manually. 

(5) Enter the new worker team number. 

(6) Press {PgDn} to go to the next record in that zip code. 

You may want to just assign the first half of the names to one team and the second half to the other. This 
is the fastest easiest way.  However it is possible that you will have teams going back and forth over a 
large territory.  It might be worth the effort to try to match them geographically.  If you are familiar with 
the territory, it isn’t too difficult to do. 
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Following is a brief description of how I use the various reports and options to get the most out of the 
program. 

Loose-leaf Books:  Each visitation team receives a loose-leaf book with two different sets of index files. 

1. A set of numerical index tabs numbered from 1 to 31. 

2. A set of alphabetical index tabs. 

Nightly Report:  Each night I print a nightly One Line report, using that option from the Print menu, and 
print those attending the last meeting.  This list is given to each team and should be filed under the 
corresponding number index in his loose-leaf book. 

Master File:  After the number of new names has slowed down, usually by the 7th night, I print an 
interest card label using the, “Print Card Label" option. 

This is filed alphabetically behind the corresponding alpha tabs in his book.  He should use this file from 
now on to keep any notes on.  If he keeps notes on the nightly print out, they will be spread throughout 
the entire book.  The master file is not kept up-to-date with attendance records, etc.  This is all on the 
nightly report.  I usually don’t print another Master file.  If any new names come in that need to be 
entered, he can just write them in. 

The Visitation Evaluation Report:  This is the one that I use to keep track of the teams visits.  It will 
only list the active names but it prints out the visitation codes for each name.  If the code reads H06P12 
you know this person was visited in their home after the sixth meeting and by phone after the 12th night. 

This report also prints out the total names of each team and the total visits made broken down by total 
names, active names and current names.  Current names are those active who have still been attending 
since the cut-off date you have chosen. 

Decisions:  After each major decision, I print out a listing of all names making that decision. 

 

The Final Week 
Review every name of those still attending and evaluate their interest level.  Update the interest level in 
the file.  There are two ways to accomplish this task: 

1. One is from the preview screen.    
2. Click the Interest option on the “Left Mouse Button Function” at the upper right of the window. 
3. Click on the appropriate name and select the interest level. 
4. Click on Save. 

An alternative method is to: 
1. Select save filter from the preview screen, master attendance list. 
2. Close the preview screen 
3. Click the mouse in the Interest level box  
4. enter the new inteeest level 
5. press PgDown to go to the next record. 

 
Be careful to assign an interest level of A, B or C to all good names.  Do not let any slip through the 
cracks.  Now you can use the Priority interest report to track your interests during the last week. 
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During the last week you should check appointments.  Use the “Need’s Baptism Interview,” reports from 
the Visitation Tools menu on the preview screen. 
See “How to use the Baptism Interview Feature” on page 37 
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Preparing the Registration Cards for Computer Entry 
The first chore in getting the names ready to enter into the computer is to separate the SDA names out 
and then arrange the visitors by families so that we can select which one to put on the mailing list.  We 
will only mail out one letter per household; therefore, we should select which names to place on the 
mailing list, and which to leave off.  In addition, it is much easier to enter the names into the computer if 
we have them grouped by families, cities and zip codes.  The following instructions make that job much 
simpler. 

 

1. Remove All SDA Names from the Stack and Keep Them Separate. 
No further sorting is necessary for these names. 

2. Arrange the Names by Family Units.  

• This saves time by allowing the typist to save time by entering the first family member and 
simply pressing [F3] for each subsequent family member.  Thus avoiding the need to retype 
address information, etc. for each family member.  

• Alphabetize the registration cards by first letter of the last name only. 

• Search each group for family units on more than one card.  For example, if a husband, wife and 
son each register separately, put them together.  Paper clips may help. 

• Decide which name is most likely to be head of the family and mark that card with a large “M” 
right under or near the phone number.  Do not spend too much time trying to decide which is the 
head.  If it doubt, just make a guess; it isn’t critical. 

• Mark the remaining cards in that family unit with a large “X” right under or near the phone 
number, and keep the cards together, for the rest of the sorting time, with the head of the house 
on the top. 

3. Arrange the Stacks by Zip Codes 
Place all the cards with the same zip code in one group, making sure you do not disturb the family 
units.  Keep the zip code groups separate by criss-crossing the cards, or with rubber bands.   
This allows the typist to use the repeat last record function [F2] instead of typing the zip code each 
time and saves entry time. 

4. Clean Up the Cards 
Keeping the cards sorted, look through the cards for any writing that is not legible and print out the 
names or other information plainly so the computer operator can type without pausing.  Look up any 
zip codes that are missing.  

5. Enter the Names 

 

Dividing the Names Among the Visitation Teams 
 

1. Print a list of all names arranged alphabetically 

2. Let each team choose any names they may know or have been working with. 

3. Manually assign the team codes. 
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4. Assign the remainder of names by zip code. 

5. Update the file.  The automatic updating by zip code only changes the names with a team code of "00" 
and not the ones which you have manually assigned a team code. 

6. Check the number of names each team has to check for balance.  Do this by selecting the Visitation 
Statistics from the Statistics screen or by pressing {ctrl-W} from the edit screen.  You should also look 
at how many "Active Names" each team has in order to adjust them too. You may need to manually 
adjust the number of names each team has to even them up or to distribute them in the way you 
decide.  

7. Go to the preview screen and look at names with duplicate addresses by selecting  "Duplicate 
Addresses with Different Team Codes" from the Duplicate Address menu.  Make sure that you did not 
assign two different team codes to two different people living in the same house. 

8. While there you can also check "Duplicate Addresses with Different Last Names" from the Duplicate 
Address menu.  This can give you an indication of possible unmarried people living together.  Keep in 
mind that it could possibly be children with different last names from the mother or even wives who 
retain their maiden names. 

9.  
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Each night after the sermon, those attending will receive a free printed copy of the sermon.  After they 
have attended nine nights, they will receive a free vinyl REVELATION NOW loose-leaf book with index 
tabs, to store the sermons in permanently.  It is important for you to understand how the notebook plan 
works. 

In order to qualify for the free loose-leaf book, each person must fill out and turn in a registration card, 
which is included in the registration packet. 

First Night Registration:  On opening night only, simply hand the registration packet to them and I will 
have them fill out the registration card at the end of the sermon.  On the opening night only, they will 
exchange the registration card for the sermon. 

On all following nights, you must register the new people at the door.  Have them fill out the registration 
card and you take it from them at that time. 

Subsequent Nights:  You should initial the front of the registration packet in the appropriate square to 
keep track of the total nights attendance each time they come.  If someone forgets their packet, remind 
them to bring it next time and you will initial it twice. 

Printed Material Cards will be turned in each night (except the opening night) after the meeting in order 
to receive the free sermons.  Insure that you have their card before giving them a sermon.  Do not allow 
anyone to use someone else’s card.  If they forgot their cards, give them one of the plain cards without a 
computer number on it. 

Video Presentations are made each night for those who missed the previous night.  When someone 
attends the video showing, and they stay for the main meeting, you should initial their card two times and 
exchange their printed materials card for the sermon in advance.  Be sure to mark TV in large capital 
letters on the printed material card and keep them separate from the cards for that night. 

Important Note:  New people should always fill out a registration card and get a packet.  Do not give a 
blank card to a new person.  If they are only going to be attending that one night, give them an un-
numbered registration card and mark on that card they will not be returning.
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Visitation Report Sheet Name & Team Code #       Date    

                                            
Name 

            
Reg. No. 

Contact 
Code 

                
Int. Level 

    
Decisions 

          
Age 

         
Time 

                                                
Remarks 

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

Contact Codes:      Decision Codes: 

P - Phone C - Accepts Christ 
H - Home S - Accepts Sabbath 
M - Meeting K - Keeps Sabbath 
 P - Sabbath Work Problem 
Followed by the number of the last meeting. B - Desires Baptism 
For example:  “H3” means visited in their  T – Tobacco / Health 
home after the 3rd night. A – Second Advent 
 D - Clear on Death   
 U – Unite with Church 
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